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Why computerize? 
 

3 Essential Questions for Independent Retailers 

1. Why Computerize Your Store? 

A Cash Register Replacement. A Computerized Cash Register system 
replaces your old fashioned cash register. A Cash Register has a single 
purpose. It tells you how much money your business has taken in during 
the day. It can tell you that you took in $350, but it can't tell you how 
much of that money is profit. It can't tell you how much inventory you 
have on the shelf. It can't tell you how many bottles of soda your business 
sold today. A computerized cash register can instantly tell you that you 
have $350 in your cash drawer. It will tell you that $225 of that $350 is 
profit. It can tell you that you sold 12 copies of a certain compact disc 
today and that you still have 8 copies on the shelf. It can also tell you what 
items you should order today because your stock is low. 
 
Reduce Theft. By computerizing you can reduce theft in your business by 
an average of 2 ½%. An average small business doing $500,000 per year 
can reduce in-store theft by an average of $12,500. How? Your employees 
become more involved in watching the store inventory if they know that 
every piece of inventory in your business is being monitored. 
 
Reduce Inventory Shrinkage. By watching your inventory and 
comparing on shelf inventory to your computerized reports, as well as 
taking regular physical inventories, both you and your employees are 
much more careful about giving away inventory, retaining obsolete 
inventory, monitoring breakage and non-theft inventory that "walks" out 
of your business, as well as checking inventory as the items enter your 
store. You can reduce inventory shrinkage by up to another 2 ½% by 
computerizing. 
 
Reduce Your Inventory. By watching your inventory reports, you can 
make sure that you order more wisely. You don't need 750 Christmas CDs 
on the shelf in the summer. 
 
Increase Your Inventory. You don't need 750 Christmas CDs in the 
summer, but you may need more portable CD players for your store 
during the month of August. Many stores order products based on what 
they think they sell. If you check your inventory reports and see that you 
sold 100 portable CD players last August, it gives you a good clue to help 
make sure that you don't run out of portable CD players this August. 
Watching your inventory reports increases your efficiency. 
 
Watch Your Margins. By analyzing your inventory better, you may 
determine that certain genres of music produce higher profit margins than 
others. Our POS software will help you to stock more products that give 
you greater profits and fewer products that give you the least amount of 
profit. 
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On average, 
computerizing will 

save you 5% of your 
sales. 

 
A business doing 

$500,000 per year in 
sales will save $25,000 

per year by 
computerizing. 

 
 A typical single user 

station computer 
system with printer, 

cash drawer, 
computer, barcode 

scanner and barcode 
printer costs less than 

$5,000. 
 

The typical computer 
system above will 

save you $20,000 in 
the first year alone!! 

Speed Customer Checkout. Computerizing speeds up your customer 
checkout. With a barcode scanner you can checkout a customer much 
faster than the time required with a manual cash register.  
Accuracy. Every item in your store has a price and barcode number 
associated with it. Never again will you have to figure out how much or 
how many you have in stock. Your clerks will have instant stock 
information at their finger tips. 
 
Keep Track of Your Customers. Your best customers are your present 
customers. No matter what type of store you have, you should try to 
obtain the name and address of every one of your customers. Keeping a 
customer list is an obvious asset for a music store. You want your 
customers to keep coming back, especially when you have a sale. Mailing 
to your customers periodically keeps them coming back. Your vendors 
may even help you pay for the cost of the mailing. Mailing to your 
customers is the best form of advertising, even if it is just a quick postcard 
listing a few new sale items. Every mailing to your customer list will 
always be a positive to your cash flow.  

2. Why Choose Musicware POS, Praiz POS or 
ExtremePOS? 

We know music stores! Musicware POS software has been servicing 
record stores for almost 20 years. Our dedication, knowledge, experience 
and commitment to the industry is unmatched. Our software is 32-bit 
Windows based and is extremely intuitive and feature packed. We have 
uniquely designed software for stores buying and selling both "new" and 
"used" inventory. Because of this unique business requirement, 
independent music stores need software specifically designed to handle 
new and used items.  
 
We know bookstores! Praiz POS software has been servicing bookstores 
for almost 10 years. Our dedication, knowledge, experience and 
commitment to the industry is unmatched. Our software is 32-bit 
Windows based and is extremely intuitive and feature packed. We have 
uniquely designed software for bookstores buying and selling both "new" 
and "used" inventory. Because of this unique business requirement, 
independent bookstores need software specifically designed to handle new 
and used items.  

3. Why Now?  

Why wait any longer! Start benefiting from technologies that can save 
you money and make you more efficient now. Give your store the same 
advantages that larger chain stores enjoy at a fraction of the price! 
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Installation Notes 

 
Important Note:  Musicware for Windows, Praiz for Windows and eXtremePOS versions have 
different naming conventions but the installation procedures are virtually the same. 
 
1.  Make sure you have the necessary computer hardware to run ExtremePOS: 
 

 
Suggested Setup: 
 
• PC with 2 GHz processor or better, 1GB of RAM or better 
• CD-RW for archiving of backup files 
• Removable media, such as USB drive, Zip drive, or USB memory stick may be used for 

backups and other activities. 
• MicrosoftWindows XP or higher 
 
 

2.  Network Installation:  The database server used by ExtremePOS is Microsoft SQL Server 2008 
Express, which is essentially a scaled-down version of the full Microsoft SQL Server product.  It is 
recommended that you designate the most powerful computer on your network to run the database 
server.  Obviously, if you have a server computer you currently use for other applications, this will 
probably be the best choice to also host your database server. 

 
 
3.  Receipt Printer Driver:  To use a receipt printer with ExtremePOS you will need a driver for your 

printer.  To install a driver, go to the Windows Control panel and choose Printers.  When your list of 
installed printers is shown, choose the first item, Add Printer .  During the process, select Generic as 
the manufacturer, and then choose Generic / Text Only.  Finish the printer installation.  You are now 
ready to print to your receipt printer.  Exception:  When using a Star receipt printer on COM 1, just 
choose NONE as your receipt printer under default printers.  It is not necessary to install a printer 
driver when your Star printer is on COM 1. 

 
4.  Barcode Printer Driver:  To use the 2” or 4” Advantage printer with eXtremePOS, please install its 

appropriate driver.  The 2” only model uses the Advantage BD 2 driver, while the 4” uses the 
Advantage BD 4 driver.  The Bixolon printer uses the Samsung/Bixolon driver.  The driver is included 
on the CD-ROM, which ships with the printer.  You can also download the driver from the 
manufacturer’s website.  Please refer to the unit’s user manual. 
 
A Note on USB Barcode Printing: 
 In order to use a USB Barcode printer, you will need to set it up using the net use command.  In order to do 
this, install the driver for your printer twice, once on the usb port and once on an unused lpt port.  Make certain 
you note the number of the port you use.  Share the usb driver.  Click on the run window, and type cmd into it and 
run it.  In the shell that opens, use the following command: 
net use lpt1: \\{your computer name}\{printer share name} /p:yes 
Replace lpt1: with the appropriate port number.  When setting up printers in ExtremePOS, you will need to select 
the printer driver for the lpt port driver.  Contact support if you need assistance with these instructions.  As of 
version 3.0, this is not necessary for Zebra or Bixolon label printers. 
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Installation Procedures 
 

Important Note:  The installation instructions below will refer to ExtremePOS, but they also apply to 
Musicware and Praiz. 
 
These instructions apply to those installing ExtremePOS 2.9 to a system that has not 
previously had a copy of ExtremePOS version 2 on it.  For those who are doing an 
upgrade, please see the document “Upgrade Instructions for ExtremePOS 2.6 to 2.9” 
 
YOU SHOULD INSTALL ON THE STATION YOU INTEND TO USE  AS A 
SERVER FIRST. 
 
To do the installation, you will need to run setup.exe. Follow through the prompted 
screens.  Make certain you install for All Users if you are planning on having multiple 
Windows accounts access the computer. Once the EPOS Core has finished installing, you 
will need to go back to the ExtremePOS Install and run it.  Depending on your version of 
Windows and other installed programs, you may be prompted to install additional 
programs upon running the “setup.exe” located in this directory; if so, allow them to 
install. 
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You will be required to agree to terms and conditions of the license for each program at time of install. 

 

Once again, follow through the prompts of the installation program.  You will be required 
to agree to the license agreement to perform the installation. 
 
On your desktop, you will now find a shortcut for ExtremePOS, with a barcode logo.  
Run it. 

 
 
You will be prompted to select a database server.  If this is the station you intend to use as 
your server, then select “Install ExtremePOS SQL Server Express instance on this 
computer”.  Otherwise, select your server instance from the list of computers on the 
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dropdown box.  If your instance is NOT named Extremepos then you will need to select 
“Use another SQL Server Instance”.  Make certain you use the same instance on all PCs. 
 
THE FOLLOWING SECTION APPLIES ONLY IF THIS IS THE S ERVER 
STATION.  OTHERWISE, SKIP THESE STEPS UNTIL THE NEX T BOLD 
INSTRUCTION. 
 
If you select to install a SQL Server instance, the software will be automatically 
downloaded and the installation process will be launched.  You may accept the default 
settings for the server, including accepting the license agreement. 
 
By default, the server instance name is “ExtremePOS”.  If necessary, you may name it 
something else, but you will need to know what you call it. 

 
 
 
ONCE YOUR SERVER IS INSTALLED OR IF YOU ARE NOT ON THE 
SERVER, FOLLOW BELOW: 
 
You will be asked if you have installed the ExtremePOS Core files.  You should say “No” 
the first time you get this screen, and the ExtremePOS Core files will be downloaded and 
installed. 
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Select the EPOSCore file when prompted.  If you installed to a non-default directory, you 
will need to browse to the install path that you had selected.  Finally, you will be asked to 
register. 
 
Fill in the Serial Number and your Customer number from ExtremePOS, or select demo 
if you are installing a demonstration copy.  If this is successful, then the program is ready 
to use! 
 



 

ExtremePOS 9

 
 
 



Chapter 1: Initializing Your Software 

ExtremePOS 10 

 

SETTINGS IN WINDOWS FOR MULTISTATION INSTALLS: 
 
If you are setting up a multistation system, you will need to make certain that you have 
certain settings correct.  Primarily, you will need to make certain that your firewall is 
correctly configured.   
 
By default, in whatever firewall program you use TCP and UDP ports 1433 and 1434 
should be opened.  However, this can vary from system to system and from program to 
program. 
 
For the default windows firewall, these exceptions may be set by going to START -> 
CONTROL PANEL -> WINDOWS FIREWALL.  Go to the EXCEPTIONS tab and 
click ADD PORT.  You will need to separately add the TCP and UDP Port. 
 

 
 
Should you need help with this, please contact Extreme Point of Sale, Inc, Support at 
919-387-7595x101. 
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Backing Up Your Data 
 

 
You should perform frequent backups of your database to protect yourself against data loss due to computer 
hard drive failures or other catastrophic events.  At a minimum, you should back up daily, but you may also 
want to back up periodically throughout the day.  Database backups can be performed from the Launchpad 
by pressing the backup database button.  There are a few important points to consider when backing up your 
data. 
 
CHOOSING A BACKUP LOCATION . 

 
The following are some options you may choose for your backup location. 

1. Keep the default location on your server computer.  There are some disadvantages to keeping this 
location.  If you keep this location, both your database file and your backup files will reside on the 
same physical hard drive.  Therefore, you put yourself at risk of losing both your data and backups in 
the event of a hard drive crash on your server.  If you do choose to keep this as your backup location, 
you should copy your backup files frequently to another media, such as a CD, and keep them in offsite 
storage. 

2. A removable media on your database server.  Some examples are a USB drive, ZIP drive or a USB 
memory sticks.  USB memory sticks have the advantage or being small, portable, capable of storing 
large amounts of data (up to 1GByte or greater) and have become inexpensive.  One benefit of 
removable media is that you can physically take your backups with you, protecting yourself against 
data loss in the case of fire or theft.  You will want to periodically archive your backups to a permanent 
media, such as CD, for added security and to keep your removable media from filling up. 

3. Another computer on your network.  This option will protect you from data loss in the event of a hard 
drive crash on your server.  If you select this option, you should also periodically copy your backup 
files from the backup location to another media, such as a CD, for offsite storage.  There are some rules 
you need to be aware of when backing up to a network computer. 
• You will need to create a Network Share on the computer that you wish to use for backups.  SQL 

Server does NOT recognize “Mapped Network Drives”.  If you specify a mapped drive as the 
backup location, the backup will fail. 

• The network share name and the directory path cannot currently contain any spaces.  ExtremePOS 
will prevent you from selecting any paths containing spaces. 

 
 
 

 
A backup file will maintain snapshots of the original full backup and all appended differential backups.  
In the event that you need to restore your database, ExtremePOS will allow you to restore to any of 
these points in time.  
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ExtremePOS, Musicware and Praiz  
 

 
 
The first time you start ExtremePOS, Musicware or Praiz you will need to provide the program with some 
initialization information.  The following section will guide you through the initialization steps.  
  
NOTES:  
• ExtremePOS is depicted in this section; however the steps below also apply to Musicware and Praiz. 

 
1. You will now see the welcome screen, as shown below.  Select Continue to proceed.  Selecting 

Cancel will exit the initialization procedure. 
 

 
 
 

 
 
2. You will now need to select your Shared Files directory.  The Shared Files Directory is the 

location that ExtremePOS Maintenance Manager and all ExtremePOS, Musicware or Praiz POS 
stations keep common files, such as reports, vendor database files and program updates.  Whatever 
Shared Files directory you have already selected for ExtremePOS Maintenance Manager, you 
should point to the same directory when initializing your POS stations. 
Select “Browse” to choose a directory.  Once you have selected your Shared Files directory, select 
“Continue” to proceed.  Selecting Cancel will exit the initialization procedure. 
 
NOTES:  
If you are installing ExtremePOS on multiple stations, you will need to make sure your Shared 
Files directory is enabled for Network Sharing in Windows.  Network users will require full access 
(Read, Write and Modify) to this directory.  See Windows documentation for information on 
sharing directories. 
If you are an existing Version 1 user upgrading to Version 2, you will not need to select a Shared 
Files directory, and you will not be shown the select screen.  By default, the Shared Files directory 
will be set to your Version 1 “Store Data directory”. 
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3. You will now be asked to select a Station ID for this station.  Select the desired Station ID and hit 

OK to continue.   
 

You should now see the confirmation screen below indicating that the new station has been created 
in your store database.  Select OK to continue. 
NOTE:  If you are an existing ExtremePOS, Musicware for Windows or Praiz for Windows 
Version 1 user, the Station will probably already exist in your database.  In this case, you will not 
see the confirmation screen. 

 

 
 

 
4. You will now see the ExtremePOS login screen.  You have now successfully completed 

initialization of ExtremePOS. 
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Log-in Screen 
 
Note:  Musicware and ExtremePOS users will see slightly different screens. 
 

 
 

The first screen that appears when you run PRAIZ® is the Log-in Screen.  To log in, type in the password 
for the shown cashier ID, then press <ENTER> or click on Login.  To log in as the administrator, type in 
the administrator password under any Cashier ID.  To log in as a cashier under a different cashier ID, type 
in the desired ID in the Cashier ID field, then enter that cashier’s password.  You may only change Cashier 
IDs if you have manually added in the ID through the Tools menu.  This option is enabled in both the single 
and multi-user versions.  
 

The default Administrator Password is: admin 
 

The default Cashier Password is: cashier 
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File and Tools Menu 
File Menu 

 

 
 

The File menu on the Log-in screen contains a choice for exiting the program.  To access the File menu, 
click on File or press <ALT+F>.   
 
 
 
 

Tools Menu 
 
The Tools menu on the Log-in Screen allows you to redefine your original specifications such as industry 
selection, the location of your store directories and database server.  You can also change cashier and 
administrator passwords.  To access the Tool menu, click on Tools or press <ALT+T> .   
 

Tools>Options Menu 
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Change Passwords 
 

The default Administrator Password is: admin 
The default Cashier Password is: cashier 
 
This section allows you to change a password for a cashier or the administrator.  To access this screen, 
select Change Passwords from the Log-in Screen Tools menu. 
 

 
 
 

To change a Cashier Password 
 

• Type the Cashier ID for which the password will be changed in the Cashier ID field. 
 

• Type the old cashier password in the Old Password field. 
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• Type the new password to be used by this cashier in the New Password field. 
 
• Re-enter the new password in the Verify New Password field to ensure no errors in typing. 
 
• Click on OK  to store the new password. 

 
To change the Administrator Password: 
 

• Type the current administrator password in the Old Password field (If you forget the 
administrator password, contact ExtremePOS). 

 
• Type the new password in the New Password field. 

 
• Re-enter the new password in the Verify New Password field to ensure no errors were made 

in typing, and then click on OK  to store the new password. 
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Select Shared Files Directory 

 

 
 

 
This option allows you to change the current Shared Files directory.  The Shared Files directory is initially 
selected during program initialization.  For more information and rules/guidelines on selecting your Shared 
Files directory, see step 4 in the ExtremePOS Initialization documentation in Chapter 1. 
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Tools>Employee Maintenance Menu 
 

 
 
 

This screen allows you to create or update a cashier ID.  To use this function, select Employee 
Maintenance from the Tools menu. 
 

 
 
The following fields are displayed for each Cashier ID: 
 
Employee Department: Use this list of departments to classify your employees.  To select a department, 
click on its name.  For more information on creating employee departments, see Chapter2: Inventory 
Control: Departments. 
 
CashierID: This is the current Cashier ID.  To select a different Cashier ID, use the Next and Previous 
buttons or click on the Cashier ID button, enter the desired two digit ID, then press <ENTER> or click on 
OK . 
 
Password: This is the password for the displayed employee.  The default password for new cashiers is 
Cashier.  You may also change this password by selecting Change Passwords in the File menu.  For more 
information, see Change Passwords. 
 
Card Swipe ID: This is the value encoded on the employee’s ID card.  Use this for quick logon/logout. 
 
Associated Customer #: If the employee has a customer number, enter it here by clicking on the 
Associated Customer # button, finding the correct Customer Number, then clicking Add.  The default 
Customer Number is 101. 
 
Hourly Wage: This is how much the employee is paid per hour. 
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To add a Cashier ID: 
 

• Click on Tools or press <ALT+T>, then select Employee Maintenance.  You will be 
prompted to enter the administrator’s password. 

 
• Click on Add or press <ALT+A> . 

 
• Enter the new Cashier ID and the employee’s information.  When you are finished, click on 

Done or press <ALT+D> .  To quit without adding a Cashier ID, click on Cancel or press 
<ALT+C> .   

 
NOTE:  Cashier IDs must be two characters long. 

 
 
To update a Cashier ID: 
 

• Click on Tools or press <ALT+T>, then select Employee Maintenance.  You will be 
prompted to enter the administrator’s password. 

 
• Change the desired fields, then click on Update or press <ALT+U>  to save your changes.  

Click on Exit  or press <ALT+X>  to quit without saving. 
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Permissions 
 
This screen allows you to specify which functions a certain cashier can use.  To access this screen, select  
the Permissions tab: 
 

 
 
 

 
 
To change the functions allowed for a cashier: 
 

• Press <TAB> to move through the different functions.  If you want a function to be allowed, 
choose Yes from the drop down list box.  Choose No if you do not want a function to be 
allowed.  Choose Prompt if you want to be prompted for the administrator’s password or 
another cashier with override permission’s id and password.  Choose Override if you want to 
allow the cashier to enable other cashier’s Prompts.  If you make a mistake press <SHIFT>  
and <TAB> to move back to the previous field. 

 
• Click on Update to store any changes or click on Cancel to ignore any changes made. 

 
• To modify settings for another Cashier ID, click on Next or press <ALT+N> , or enter the 

desired Cashier ID, then press <ENTER> or click on OK . 

 
 
 

To change a Cashier Password 
 

• Type the Cashier ID for which the password will be changed in the Cashier ID field. 
 

• Type the old cashier password in the Old Password field. 
 

• Type the new password to be used by this cashier in the New Password field. 
 
• Re-enter the new password in the Verify New Password field to ensure no errors in typing. 
 
• Click on OK  to store the new password. 
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The Invoice Screen 
 
 

 
 

ExtremePOS works 
with or without a 

mouse.  You can access 
most features of 

ExtremePOS using an 
ordinary keyboard.

 
After successfully entering your password, you will enter the Invoice 
Screen.  Everything you will need to do in EXTREMEPOS works from 
this one screen.  Most features in ExtremePOS works with or without a 
mouse.  You can move around the entire screen using either <TAB> or 
any of the numerous <ALT>  shortcut keys.  You can bring up additional 
ExtremePOS screens using the <CTRL>  shortcut keys. 
 
Any underlined letters on the screen are <ALT>  shortcut keys.  For 
example, look at the word Tools in the menu bar.  You can access Tools 
either by clicking your mouse on the word Tools or by pressing the 
<ALT+T>  shortcut keys (press <ALT>  and T simultaneously). 
 
You can also use <TAB> to go from one section of the screen to another.  
Press <SHIFT>  and <TAB> simultaneously to go backwards.  For 
details on the Invoice Screen, see Chapter 4: Creating Invoices. 
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The Menu Bar 
 

 
 

Access the Menu Bar 
by using the <ALT> 

keys or a mouse. 
 

For example: 
 

<ALT+T> = Tools 
 

<ALT+V> = View 
 

<ALT+R> = Reports 
 

You may use lower or 
upper case letters. 

 
<ALT+T> = <ALT+t> 

You can access the Menu Bar by using a mouse or your <ALT>  key.  
You can access each menu listed on the menu bar by simultaneously 
pressing <ALT>  and the underlined letter in the menu title.  To leave the 
menu bar, press <ESC> twice or press another <ALT>  key to reach 
another part of the main screen.   
 
You can also press <ALT>  to access the menu bar and then use the left 
and right arrow keys (<←←←←> and <→→→→>) to move from one menu to 
another.  Press <↓↓↓↓> to display the highlighted menu. 

 
The eXtreme Toolbar 

 
The eXtreme Toolbar is a navigation control that brings the look of Microsoft 
Oulook to eXtremePOS.  It incorporates a system of sliding groups, each of which is 
identified by its header.  Clicking a group’s header causes the group to become active, 
slide into view, and diplay the items it contains.  The eXtreme Toolbar gives the user 
an easy way to access the most commonly used ExtremePOS features.  For example, 
the Store Maintenance group contains shortcuts to inventory, customers, vendors, 
departments, categories, purchase orders and setup options.   
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Options Screen 

 
 

Click on the appropriate tab to select which settings to change. 
 

The Options Screen allows you to customize the features you use in ExtremePOS.  To view the Options 
Screen, select Options Screen from the Invoice Screen Tools menu.  Each of the different settings is fully 
explained in the following paragraphs.  Click on Update to save your changes or click on Exit  to ignore all 
changes. 
 
Printers and Hardware 
 
Use this option to specify the settings for your printers, cash drawer, pole display, and PD-1 ECR Scale.  To 
change any of these settings, click on the Hardware tab in the Options Screen, and then click on the 
appropriate port setting.   
 
Receipt Printer Driver: ExtremePOS will print receipts to the printer listed here.  For most users, those 
who are using a printer plugged in to the serial port COM1, drivers for the receipt printer are not needed.  
Instead, use Direct to COM1.  For those using USB receipt printers, you must install the drivers in 
Windows and select the correct one here. 
 
Report Printer Driver:   If you have a printer for your reports, you must install the drivers for it in 
Windows before using it in ExtremePOS.  After the drivers have been installed, select the printer you wish 
to use here. 
 
Barcode Printer Driver:  If you have purchased a barcode label printer, you must install the drivers into 
Windows before you may use the printer here.  The drivers come either from the printer’s manufacturer’s 
web site or from the driver CD sent with the device.  Make certain you select the correct model. 
 
Receipt Printer Type:  Select the type of receipt printer you have.  Other than Star, most receipt printers 
emulate Epson style printing. 
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Pole Display Port: ExtremePOS will display invoice items, associated prices, and a running total on a pole 
display as items are added to an invoice.  Pole Display should be turned off if you do not have a display.  If 
you do have a display, you must specify the COM port to which it is attached.   
 
Pole Display Type: Use this option to select what type of Pole Display you are using.  If you are using the 
Extreme Customer Display application, you may select that.  You need not specify a com port for that 
program, 
 
Cash Drawer Port: Use this option to specify the location of your cash drawer.  Cash Drawer Port 
should be set to “None” if you do not have a cash drawer.  If you do have a cash drawer, you must specify 
its location - COM1, COM2, LPT1, or LPT2.  If your cash drawer receives its power from the receipt 
printer, you should set your cash drawer port to the same port as the receipt printer. 
 
Receipt Cutter: This option allows you to set up an autocutter used with your receipt printer.  If your 
printer has one and you wish to use it, set the radio button to ‘yes’ and the appropriate commands in the box 
below.  The drop down menu includes the two most common by default; the first listed is for most Star 
printers and the second is for most Epson compatibles. 
 
Print Logo:  This option may allow you to print a store logo on your receipts; for further information, 
consult your printer’s documentation. 
 
Cipherlab Device:  This allows you to set the port and speed for the Cipherlab 8000. 
 
 

 
 
Receipt 
 
 
Receipt Size: Use this option to select the paper size to be used for invoice receipts from the following 
selections: Receipt, Full, Full Professional, or NEBS 9245-4.  To change your receipt paper size, click on 
the Receipt tab in the Options Screen.  Full Professional is designed to print on a standard laser printer. 
 
If you select Full Professional, the Prof Logo option is displayed.  You may choose to include a picture, 
company info, or both a picture and company info on the receipt.  NOTE: The selected picture must be a 
.jpg or .gif file. 
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If you select Receipt and your receipt printer is defined as Generic under Windows, use the Windows 
printer setup option to indicate No Page Breaks to ensure that the printer will not eject a full page when 
each receipt is printed.  EXTREMEPOS automatically prints a few blank lines to allow tearing between 
receipts. 
 
If you select NEBS 9245-4, you must set the paper size as User Defined in the Windows printer setting. 
Print Invoices: Use this option to indicate whether invoices should be printed automatically or if you 
should be prompted to print each invoice.  To change your Print Invoice settings, click on the Receipt tab in 
the Options Screen.  Select YES to automatically print out an invoice upon completion of a transaction.  
Select NO if you don’t want invoices to print at all.  Select PROMPT if you only want invoices to be 
printed at certain times.  You will be prompted to print an invoice each time you end a transaction.  Select 
CC Only to only print a receipt for credit card invoices. 
 
Display Equals: If you select Yes for this feature, the line of equal signs separating the items from the rest 
of the receipt will print. 
 
Print Amount Saved: Enable this option to print the total difference between your selling price and the 
retail price for the invoice.  This is for non-NEBS receipts. 
 
Validate Checks:  When this function is enabled, the invoice number, date and grand total will print on the 
back of checks.  You can only use this function if you have an Ithaca slip printer. 
 
Print Kit Items:  Disabling this option means that the individual items in a kit will not print on receipts but 
will still appear on the invoice screen. 
 
Print Account Balance: When this option is enabled, the account balance will print on receipts for “on 
account” customer. 
 
Company Information 
 

 
 

This is the name, address, and telephone number that will appear on every invoice, receipt, report, or 
statement.  ExtremePOS’s company information is the default company name, address, and phone number.  
To enter your own company information, click on the Company Info tab in the Options Screen.  Use 
<TAB> to move from field to field, then replace the old company information with the desired company 
information.  Click on Update to store the new company information.  You must enter information on all 
four lines. 
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Musicware Users Only:  If you are a SoundScan reporter, please enter your reporter number, user name 
and password in the appropriate fields, as provided to you by SoundScan. 
 
NOTE:  You may only enter four digits for a Store ID number.  Please do not change your Store ID from 
the default value.   
 
Invoice Settings 
 

 
 
Prompt Cashier ID - When this feature is enabled, the cashier is prompted to enter his Cashier ID upon 
completion of a transaction.  This option may be useful if numerous cashiers are ringing up people on the 
same machine.  To change your settings for this feature, click on the Invoice Settings tab in the Options 
Screen.   
 
Stock Prompt: When this option is disabled, EXTREMEPOS will no longer prompt for special orders if an 
item is not in stock. 
 
Do not sell out of stock items:  If this box is checked,  then you will be unable to sell items for which your 
in stock number is zero or lower. 
 
Round Nearest Nickel: If this option is enabled, all extended line totals will be rounded to the nearest 
nickel.  This is useful if your tax is built into your price so you won’t have to deal with pennies. 
 
Round Up Tax to Nearest Penny:  If this option is enabled, the sales tax will always be rounded up rather 
than down.   
 
Combine Lines – When this function is enabled, multiple entries for the same item will be combined on 
one line.  For example, if CD, DVD, then CD are entered, the screen and receipt will show CD 2 @ Price, 
DVD 1 @ Price instead of CD 1 @ Price, DVD 1 @ Price, CD 1 @ Price.  This option is not compatible 
with Promotions. 
 
Prompt Salesperson: When this option is enabled, you will be prompted to enter a salesperson ID at the 
end of an invoice.  This allows you to track one person getting credit for a sale and another ringing it up on 
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the register.  NOTE:  Salespeople must be set up as cashiers for this option.  When prompted, enter the 
salesperson’s Cashier ID. 
 
Prompt Amount Tendered: Disable this option if you don’t want EXTREMEPOS to prompt you to enter 
the amount tendered.  This is useful if you want to eliminate a few keystrokes by doing the math in your 
head. 
 
Print Labels for Trade-Ins:   Use this feature to instantly print barcode labels for trade-ins at the time of 
invoicing. 
 
Always Print Price 1 for Trade-Ins:  Use this feature to print the completed price regardless of whether 
the item is complete or incomplete. 
 
Default Payment Type: This option allows you to automatically set the default payment type to “on 
account” when you select a customer. 
 
 
Last Price Lookup: When this option is enabled, a customer will automatically be rung up at the last price 
they paid for an item.  For example, if an item is normally priced at $10.00 but you sell it to a customer for 
$9.00, the customer will be rung up automatically at $9.00 the next time they purchase that item. 
 
Calculate Sales Tax On:  This option allows you to charge sales tax on just the balance of a transaction 
involving sales and trade-ins (purchasing used product from you customers).  Some states may require this 
option to be set.  This is rare so DO NOT change from the default setting of charging sales tax on the 
“Entire Price” unless you know for sure that your state requires this choice. 
 
Default Invoice Items to:  Determine whether the used box on the invoice is checked or left off by default. 
 
Enable ‘Set Used Price by Trade-in Price’ at Register: Check and enter the percentage markup that you 
want if you want to dynamically generate your prices from your trade-in values. 
 
Promotion Prices:  Set to manual if you want to manually add promotions to the invoice, automatic if you 
want your set up promotions automatically applied, and disabled if you do not wish to do promotions. 
 
Suggested Tradein Price:  Select whether you want the trade-in price to be the Used Cost field or the 
Trade-in Price field. 
 
Allow Gift Certificates:  Disable this if you do not want to accept gift certificates and cards. 
 
Search These Fields for Scanned Items:  Select the fields you want to check item numbers against. 
 
Default GC Sales to:  Select whether to do gift cards or gift receipts by default when selling a gift card. 
 
Default Gift Store Credits to: Select whether to do gift cards or gift receipts by default when having a 
remaining balance on a trade-in. 
 
Collect up to X% Above Sales Price on Pre-Books:  This allows you to take a deposit for a percentage 
above the base retail price on special orders and preorders. 
 
Add to Invoice from Instant PO:  This allows you to place items into invoices after instant POing from 
the invoice screen 
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Inventory 
 

 
 
Auto Cost Percentage for Non-Inventory Items - This feature automatically calculates the cost of a non-
inventory item based on the price entered in the Non-Inventory Item screen.  For example, suppose the 
cost percentage is set for YES and 33%.  If you add a non-inventory item to the invoice and enter a price of 
$5.00, EXTREMEPOS will automatically calculate the cost as $1.65.  If you set this option to NO, the cost 
will be whatever you enter it as.  To change your settings for Auto Cost Percentage, click on the Inventory  
tab in the Options Screen. 
 
Default Item Number Type – This option allows EXTREMEPOS to force an item number to be a certain 
type of barcode, UPC or EAN 13, when creating an inventory item.  If you do not wish EXTREMEPOS to 
force a barcode type then choose User Defined. 
 
Automatically generate Selling Price from Cost Markup:  If this is checked, your price will be defaulted 
to the cost plus the markup, set in the box to the right. 
 
Automatically generate new item Cost from Vendor Discount off Retail:  If this is checked, your item 
cost will be the retail of the item, minus the discount listed with the vendor you purchased from. 
 
Average Cost Method (New Items):  If you receive an item into stock at a new cost, EXTREMEPOS will 
automatically change the cost of this item to the average cost you have paid for the items currently in stock 
if this feature is enabled.  This method is used when receiving stock from purchase orders through the 
Purchase Orders screen.  To enable the Average Cost Method, click on the circle next to Enabled on the 
Invoice Tab of the Options Screen. 
 
Average Cost Method (Used Items):  If you receive an item into stock at a new cost, EXTREMEPOS will 
automatically change the cost of this item to the average cost you have paid for the items currently in stock 
if this feature is enabled.  This method is used when using the “Trade-ins” feature when invoicing a 
customer.  To enable the Average Cost Method, click on the circle next to Enabled on the Invoice Tab of 
the Options Screen. 
 
Use Price Tables:  If enabled, allows for the use of price tables for setting the price from the cost or the 
retail price. 
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Automatic Item Number Length:  Chooses whether, when auto generating numbers, to have them be 11 
or 12 digits. 
 
Audit Quantity changes:  If enabled, records the id of anyone directly changing the in stock number in 
inventory maintenance 
 
Require Login to enter Inventory Screen:  If checked, you will need to enter an authorized username and 
password each time you enter the inventory maintenance screen. 
 
Add Prefix to Barcodes for New Items:  Indicates that new items will have a prefix appended to their 
barcodes to indicate their newness. 
 
Add Prefix to Barcodes for Used Items:  Indicates that used items will have a prefix appended to their 
barcodes to indicate their used state. 
 
Serial Number on Purchase Orders:  Serial numbers applied on purchase ordering 
 
Popup Item Notes:  If turned on, any notes set on items will pop up when that item is placed on an invoice. 
 
Autofill Used Prices:  If this is enabled, individual items with this feature enabled will generate used 
pricing and tradein pricing from the percentages in this grid. 
 
 
 
Station Specifics 
 

 
 
Print Extra Order Copy:  When this option is enabled, an extra copy of the receipt will print to the 
specified location or the Order Filling Screen.  For example, a restaurant station dedicated to deliveries 
might want to print an entire receipt to the kitchen so it can be attached to deliveries. 
 
Show/Sort Dept. & Cat. By:  This will allow you to display either the Number OR the Name field to 
display in the drop down list boxes within the Inventory Maintenance section of the software.   
 
Show/Sort Customers By:  This will allow you to display either the Number OR the Name field to display 
in the drop down list boxes within the Customer Maintenance section of the software. 
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Show/Sort Vendors By:  This will allow you to display either the Number OR the Name field to display in 
the drop down list boxes within the Inventory Maintenance section of the software. 
Credit Card Processing 
 

 
 
ExtremePOS allows you to process credit card transactions either manually or via the Mercury Payment 
Systems credit card processing software system.  Express Manual Processing allows you to record an 
invoice as a credit card purchase without having to enter the credit card information.  The credit card type 
will be recorded as "None".  To change how you process your credit card transactions, click on the CC 
Processing tab in the Options Screen, then select the option you wish to use for credit card processing. 
 
Additionally, ExtremePOS now features integrated support with Mercury Payment Systems; you may check 
that mark and then enter your Mercury account information to the right. 
 
Additional CC Types: This feature allows you to define your own credit card types in EXTREMEPOS.  
The credit ID may only have four characters.  These credit card types can only be used in manual 
processing. 
 
Mercury Gift Cards:  This allows you to set whether you are using internal gift cards (covered in that 
chapter) or gift cards through Mercury. 
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Internet Features 
 

 
 

Ingram:  You must obtain this information from Ingram in order to use the Electronic Ordering features 
within the Purchase Order section of the software.    

 
AEC EDI:   Input your Customer Number and Ship To Number assigned to you from AEC in order to 
use the electronic ordering capabilities of Musicware when ordering from AEC. 
 
VPD Database:  Input your username and password in order to use the database from VPD. 
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Couponing 
 

 
 
This function allows you to enter text to appear as a coupon on the bottom of each receipt.  In order to use 
this function, you must be using an Epson TMT-88 printer. 
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Vendor Databases 
 

 
 
Quick Import :  This special feature of ExtremePOS is used to automatically import items from Vendor 
databases from within the POS Register invoicing screen.  This can greatly reduce inventory title data input 
by using data already provided by your Vendor.  Selecting search these databases chooses which databases 
in which order to look for an item. 
 
Superfile:  This option allows Musicware users to update and overwrite certain store inventory data to 
match the Superfile vendor database. 
 
Ingram Companion and Bowker:  This option allows Praiz users to select which format to import code 
numbers in. 
 
Restaurant Features 
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Print Tip Line on Credit Card Invoices:  When this function is enabled, a line to enter a tip amount will 
print on credit card invoices.  This option allows customers to put the tip on their credit card as well as the 
entire invoice.  To change your settings for this feature, click on the Restaurant Features tab in the 
Options Screen.  Click on YES to enable this feature or click on NO to disable it. 
 
Auto Tipping: This feature will automatically apply a tip to parties over a specified size if you are using 
touch screen invoicing.  When you choose “$$$”  from the touch screen for a party larger than the set limit, 
you will be asked if you want to add the specified percentage to the order as a tip.  To change your settings 
for this feature, click on the Restaurant Features tab in the Options Screen.  NOTE: Enter the 
percentage as a decimal.  For example, enter .15 for 15%. 
 

 
Prompt Table #: If this option is enabled and prompt Cashier ID is disabled, you will only be prompted to 
enter the table number.  This allows for faster invoicing in instances where cashier tracking is not necessary. 
 
Print Modifiers on Receipt: Enable this option to print modifiers for an item on the receipt. 
 
Account Control 
Deadbeat Control: 
 

 
 
 
When this feature is enabled, a screen will appear listing all the items that are currently rented by the 
customer when you pull up his account.  To change the settings for deadbeat control, click on the Account 
Control  tab in the Options Screen, then click on Enabled or Disabled. 
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Max Balances: This feature allows you to set a maximum balance for on account customers.  When 
enabled, customers will not be able to charge any amount on their account greater than their maximum 
balance. 
 
Touch Screen 
 

 
 
Department Selection: When this option is enabled, only the departments will be displayed in Touch 
Screen Invoicing, not the entire inventory.  To display all the items under a certain department, touch the 
corresponding button.  When department selection is disabled, the entire inventory will be displayed.  
Displaying only departments helps keep your Touch Screen more organized.  To change your settings for 
this feature, click on the Touch Screen tab in the Options Screen, and then click on YES to enable 
department selection or NO to disable it. 
 
Display Modifier Items:  When this is option enabled, all of the different modifiers for preparing an item 
are displayed in Touch Screen invoicing.  You may wish to disable this option if you want to minimize the 
number of items displayed in Touch Screen invoicing.  To change your settings for this feature, click on the 
Touch Screen tab in the Options Screen, then click on YES to display modifier items or NO to only show 
the regular inventory. 
 
Use Decimals in Numeric Entries: Disable this option if you do not want to hit the decimal button for 
numeric amounts.  For example, 1 2 5 will register as $1.25, not $125. 
 
Update 
 
This button saves or “updates” any changes you make to your current settings. 
 
Exit 
 
Click this button to exit the Options Screen. 
 
 

 



Chapter 2: Getting Started 
 

ExtremePOS 38 

Change Cashier ID 
 

 
 

This screen allows you to change the ID of the current cashier without exiting the program and logging in 
again.  Invoices are tracked by Cashier ID, and any settings saved for the Cashier ID will be automatically 
recalled.  The administrator may enter the administrator password to override any functions that are locked 
out to the cashier. 
 
To change the current Cashier ID: 
 

• Select Change Cashier ID from the Actions/Cashier Functions menu. 
 

• Type in the new Cashier ID, then click on OK  or press <ENTER>.  
 

• Enter the password for the specified Cashier ID. 
 
 

Change Cashier Cash Drawer Location 
 

This feature allows you to change the location of the cash drawer for the current cashier.   
 
To change the location of the Cashier Cash Drawer: 
 

• Select Change Cashier Cash Drawer Location from the Actions/Cashier Functions menu. 
 

• Type in the Administrator’s password, then click on OK  or press <ENTER>. 
 

• Type in the number corresponding to the desired location of the cash drawer. 
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Discount Levels 
 

 
 

This feature allows you to set up discount levels for customers.  To choose a discount level for a customer, 
type the letter corresponding to the desired discount level - A, B, C, D, or E - in the Discount Level field of 
the Customer Maintenance screen (See Chapter 3: Customer Control).  The default customer discount 
level is A.  The selected discount is automatically applied for each new inventory item added.  You will be 
able to customize the discount levels on particular items (See Chapter 2: Inventory Control ). 
 
NOTE: Inventory Level overrides will take precedence over customer discount levels. 
 
To change the value of a discount level: 
 

• Select Discount Levels from the View menu. 
 

• Use <TAB> or the mouse to move to the desired field. 
 

• Enter in the new discount percentage level. 
 

• Click on OK  to save the new values or click on Cancel to ignore any changes. 
 
NOTE: Each discount level MUST have a value. 
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Used/Trade-In Options 
 

 

  
 
From the menu Tools choose Used/TradeIn Options so the above screen is displayed.  Here you can set 
user defined descriptions for selling and buying used items based on various “conditions” of the item.  
There are two ways to do this – conditions 1 and 2, defaulted to complete and incomplete and used by 
BRE’s database among others, and a five-level A-E condition code system. 
 
Another useful feature for stores handling used items is the ability to offer your customers a lower “trade-
in” value if the customer decides to receive cash versus a store credit for future merchandise.  If you process 
a trade-in and select Cash instead of the default Credit  option at the invoicing screen, the value offered will 
be discounted by the percentage entered.   The invoice screen below is an example implementation of the 
feature: 
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Set Tax Rate 
 

 
 

This screen allows you to change the tax rate and the descriptions of each tax rate.  To access this screen, 
select  Tax Rates from the View menu. 
 
To change the tax rate: 
 

• Use <TAB> or the mouse to move to the desired field, then type in the new information. 
 

• Click on OK  to save the changes or click on Cancel to ignore any changes. 
 
NOTE:   Any changes in the descriptions of a tax rate are reflected on the printed receipts, and you must 
enter rates for all three tax levels.  Example: Canadian users may wish to label the first tax rate as GST and 
the second tax rate as PST, or liquor storeowners may want to designate the second tax as Liquor Tax. 
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General Invoice Notes 
 

 
 

This function allows you to add notes that will appear on the bottom of every receipt.  These notes could be 
a notice or a reminder about a sale date or a special offer.  You may enter up to ten lines of up to 42 
characters each.  To access this screen, click on General Invoice Notes in the View menu.  Use <TAB> or 
the mouse to move to each line.  Click on OK  to save any changes in the text or click on Cancel. 
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Customer Bonus 

 
 

The Customer Bonus screen allows you to define a bonus that a customer will receive once a specified 
number of bonus points have been accumulated.  The Activate Bonus field must be checked in order for 
EXTREMEPOS to award bonus points and determine if a customer has accumulated enough bonus points 
to qualify for the bonus described.  To access the Customer Bonus screen, select Customer Bonus from the 
View menu.  Use <TAB> or the mouse to move to the desired field, then type in the desired information.  
Click on Update to save any changes made or click on Cancel to ignore any changes. 
 
NOTE:  Bonus descriptions, cost, quantity, price, and taxable status may be overridden prior to adding the 
bonus item to the invoice.  Also, the customer may select not to take the bonus item at the time it is offered.   
 
Bonus ID: This is the default ID assigned by EXTREMEPOS.  It cannot be changed. 
 
# Bonus Points Required: This indicates the number of bonus points that a customer must accumulate to 
receive the bonus described.  Once the specified number of points has been accumulated, the bonus is added 
to the customer’s invoice - the cashier will be asked to accept (Add to Invoice) or reject the bonus 
(Cancel).  If accepted, the customer’s bonus points will be decreased accordingly. 
 
Activate Bonus: If this box is checked, bonus card information will be reviewed and applied by 
EXTREMEPOS for customers who are Bonus Plan Members. 
 
Tax: This indicates which tax is to be charged when the price of the bonus item is greater than 0. 
 
Bonus Description: This is the description that will appear on the invoice for the bonus item. 
 
Cost:  This is the actual cost of the bonus item.  Bonus items are tracked under a Non-Inventory number. 
 
Quantity:   This is the number of bonus items to be given. 
 
Price:  This is the price to be charged for the bonus item.  You can enter a price or 0 for no charge. 
 

 

Open Cash Drawer 
 

This function lets you open the cash drawer with the administrator password.  You can also use this function 
to verify that your cash drawer is functioning properly.  To open the cash drawer, select Open Cash 
Drawer from the Actions menu, type in the administrator password, and then click on OK . 
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Bar Code Overview 
 
 

ExtremePOS works with any type of keyboard wedge barcode device.  A keyboard wedge barcode device 
plugs into a “Y” type connector that allows the simultaneous use of a keyboard and barcode device using a 
single keyboard port.  ExtremePOS will also work with USB barcode scanners, which have become the 
most common interface type. 
 
The best type of barcode device to use is a Laser scanner that can read barcodes at a distance of up to 1 foot 
away without touching the barcode.  A laser scanner costs about $200.   
 
A barcode device is a simple instrument to use with ExtremePOS and it makes invoicing much easier.  For 
example, a 16-ounce bottle of Diet Coke has the barcode number 049660.  With ExtremePOS, you can 
either enter 049660 manually, or you can very quickly scan the number, just like in the supermarket. 
 
 

Inventory Functions 
 
Most Inventory functions are performed from the View Menu. 
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Inventory Maintenance 
 

 
 
The Inventory Maintenance screen allows you to add items to your inventory as well as edit existing 
inventory items.  To access this screen, select Inventory Maintenance from View menu or press <F2> in 
the Invoice Screen. 
 
Once you have accessed the Inventory Maintenance screen, you can use <TAB> or the mouse to move 
from one field to another.  To add an item, click on Add or press <ALT+A> .  Enter the desired 
information, then click on Save or press <ALT+S> to save the new item.  To update a selected item, change 
the desired information then click on Update or press <ALT+U> .  To exit without making any changes, 
click on Exit  or press <ALT+X> .  To quick import from a vendor database set up in the options menu, 
click on the Quick Import  button. 
 
NOTE:  Item Number and Item Name are required fields.  You MUST enter an item number and 
description for each item. 
 
General Info 
 
To access the General Info page, click on the General Info tab or press <ALT+G> . 
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Item Number: This is where you enter the unique identifier for an item.  It can be up to 18 characters long 
and consist of any combination of letters and numbers.  However, if you are using barcodes, as is 
recommended, you may only use numbers in the item number.  This is the field to store your “barcode” 
number in order to scan an item at the invoicing/POS screen quickly.  NOTE: Do not use any punctuation 
or spaces, except for the underscore (_), as part of the item number. 
 
Item Type:  Here you can force consistency and select a “type” of item number from the drop down list.  
The options are UPC, EAN13 and User Defined.   
 
Alternate Item Number:  This field can store a second number to search against in various lookup fields 
when searching your inventory. 
 
Item Number 3:  This is yet another number to describe and search your inventory against.   
 
Item Name (Title): This is the description of the item that will appear on invoices and reports.  It is best to 
use the title of the item for this description field.  It can be up to 30 characters long and consist of any upper 
and lower case letters, numbers, punctuation, or spaces.  NOTE: Do not use the asterisk or apostrophe (* 
or ‘) as part of the item name. 
 
Item Description:  This is another description field used to further describe the item.  As an example, let’s 
say you’re describing a compact disc, so you would use this field for the artist of the piece for example 
“Enya”.   In the case of describing a book, this should be your “Author” field. 
 
Second Item Description:  Yet another description field for identifying inventory.  Again using the CD 
example, this would be a useful field for the “Composer” description.  
 
Manufacturer (Publisher or Label):   Here you can track the manufacturer of the item you are selling.  CD 
Stores can use this field to track the record label.  Bookstores should use this field to track the publisher. 
 
Department: This allows you to select a department for the inventory item.  Scroll through the Department 
list by using the cursor keys (<←←←←>, <↑↑↑↑>, <→→→→>, <↓↓↓↓>) or by clicking on the up and down arrows with your 
mouse. NOTE:  The Department must first be added through Department Maintenance under 
Departments in the View menu.  For more information on creating departments, see Chapter 2: Inventory 
Control – Inventory Menu – Departments. 
 
Category:  This allows you to select a category for the inventory item.  Scroll through the category list by 
using the cursor keys (<←←←←>, <↑↑↑↑>, <→→→→>, <↓↓↓↓>) or by clicking on the up and down arrows with your mouse.  
NOTE:  The category must first be added through Category Maintenance under Category in the View 
menu.  For more information on creating categories, see Chapter 2: Inventory Control – Inventory 
Menu – Categories. 
 
Date Entered:  This field will be entered automatically when adding and saving an item. 
 
Last Date Sold:  This field will be automatically updated by selling this item. 
 
In Stock: This displays the current number of this item that is in stock.  It is automatically updated after an 
invoice and can be changed manually at any time. 
 
Reorder Level: This is the quantity at which you will be alerted to re-order the item.  It can be up to 5 
digits long. 
 
Reorder Quantity: This is the default quantity that will be placed on a purchase order for this item.  This 
quantity can be modified at any time. 
 
Location:  This allows the user to specify a location on the sales floor where this item is found. 
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Cost: This is how much you paid for the item. 
 
Price: This is how much you are selling the item for. 
 
Retail Price: This is the manufacturer (or vendor’s) suggested retail price.  This field is for informational 
purposes only. 
 
Set Price from Price Table:  This button will only appear if the Use Price Tables option is set.  It will set 
a price from your price table, established under View and then Price Tables in the main screen, from either 
your cost or your retail price. 
 
Tax: This indicates which tax(es) should be charged to this item.  Click on the box next to the desired tax 
level(s) to choose the type of tax to be applied to this item. 
 
Profit %:  This displays the profit percentage for the displayed item. 
 
Retail Discount: This displays the retail discount percentage for the displayed item. 
 
Gross Margin: This is the percentage of the selling price that is profit. 
 
This Is A Discount Card:  This marks the item as a discount card; the in stock number of a discount card is 
permanently set to 0.  When selling one, it is assigned an individual number and assigned to a customer. 
 
Promotions:  For Discount Cards only, this allows you to associate promotions with this card.  They must 
already be set up as discount card promotions from within the promotions menu. 
 
Print Labels:  This button allows you to print barcodes “on demand” to the system barcode printer. 
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EXTREMEPOS offers two sizes of  “barcode” labels to print, 2 X 1 inch and 4 X 1 inch labels.   
 
Select Fields to print:  This function allows you to include or exclude various fields on the barcode you 
want to print.  Simply check or uncheck the various choices.   
 
Select Barcode Printer:  This allows you to select your barcode printer, e.g. the Cognitive Barcode 
Blaster. 
 
Select Number of Labels:  This allows you to enter the number of barcodes you wish to print for the 
inventory item. 
 
Select Barcode Type:  This allows you to select a type of barcode to print.  The choices are EAN13, UPC 
and Code39 (User Defined).  The label will print with the check digit included for both EAN13 and UPC, 
even if the check digit is not saved in your item number. 
 
Select New or Used Price:  This allows you to select which selling price to include on the label. 
 
Print:   Click Print  when you are ready to print the labels or press Cancel if you change your mind. 
 
 
 
Vendor Info 
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 Primary (preferred) Vendor:  This allows you to select a preferred vendor for an item.  Scroll through the 
vendor list by using the cursor keys (<←←←←>, <↑↑↑↑>, <→→→→>, <↓↓↓↓>) or by clicking on the up and down arrows with 
your mouse, then highlight the desired department.  This vendor will be the default vendor for purchase 
orders of this item.  NOTE:  The vendor must first be added through Vendor Maintenance under Vendors 
in the Inventory  menu.  For more information on adding vendors, see Chapter 2: Inventory Control –  
Inventory Menu – Vendors.  You may also choose a second and third vendor.  Note:  Musicware and 
Praiz users may assign unique part numbers and vendor costs (either by cost or discount).
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Optional Info 
 
To access the Optional Info page, click on the Optional Info  tab or press <ALT+O> . 

 
 
Days Valid: This is for how many days an item is valid.  It is usually used for tickets and vouchers and is 
for informational purposes only. 
 
Bonus Points: This specifies how many bonus points a bonus plan member will receive when purchasing 
this item. 
 
Bulk Pricing:  This function allows you to sell items in bulk for a price different than selling the same 
amount of items individually.  Type the number of items in bulk in the first field and the special price in the 
second field. 
 
Sale Pricing: This function allows you to place an item on sale for certain dates.  Enter the percent you 
want the item to be marked down in the % off field.  Enter the beginning date in the Starting field and the 
ending date in the Ending field.  NOTE:  To place an item on sale for only one day, enter the same date 
in both date fields. 
 
Street Date: This field allows the user to establish a street date when the item is available for sale.  
Preorders made will not be able to be picked up until this date. 
 
Pre-Order Item:  Check this box if the item is for sale as a preorder. 
 
Minimum Payment:  The minimum payment to reserve a preorder of the item 
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Preorder Date:  The date on which the item may first be preordered. 
 
Serial Numbers: Select Yes if you want to have serial numbers for this inventory item.  At the time of sale, 
you will be prompted to enter a serial number.  The maximum is 20 characters and it may contain both 
letters and numbers. 
 
Print Tickets:  When this function is activated for an item, a ticket will print when the transaction is 
completed.    Tickets can only be printed using a Monarch 9820 printer. 
 
Auto Weigh:  When this option is enabled for an item, EXTREMEPOS automatically takes the weight 
from the ECR Loc scale when the item is added to the invoice. 
 
Modifier Item:  A modifier item is an item that accents another inventory item.  For example, if you 
ordered a hamburger, ketchup would be considered a modifier item.  To mark an item as a Modifier Item, 
select Yes. 
 
Print Vouchers: When this function is activated for an item, a voucher will print when the transaction is 
completed.  Vouchers can only be printed using a Monarch 9820 printer. 
 
 
Discount Levels 
 
To access the Discount Levels page, click on the Discount Levels tab or press <ALT+D> . 
 

   
 
Discount Levels: These are the discount percentages and the respective discount price for an item.  The 
discount prices are displayed once a price has been entered for an inventory item.  When the price is 
changed, the discount information is updated to reflect the change.  If the discounted price or percent is 
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different than those from Setup discount levels, the inventory levels will take precedence.  If you enter a 
discount price, the percent will be updated.  If you enter a percent, the discount price will be updated.  
NOTE:  The levels will default to the Setup discount levels, but these may be changed at any time. 
 
For an item to be discounted for one or more customer discount levels (A-E), the level must be enabled for 
the item.  To enable a discount level, click on the box under Enabled in that discount level’s row.  If a 
discount level is not enabled, customers with that level will be charged full price. 
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Matrix and Modifiers 
 
To access the Matrix and Modifiers page, click on the Matrix/Modifiers  tab or press <ALT+X> .  This tab 
will only appear if no department has been selected or if the selected department is not a rental department. 
 

 
 
Group:  This function allows you to select a group for the inventory item.  A group is a way to classify an 
item that has different styles.  For example, you may have a long skirt that comes in four colors (white, blue, 
black, and purple) and three sizes (Small, Medium, and Large).  In order to keep track of how many of each 
color and size you have, you need to use a group, such as Long Skirt.  Each size in each color can have its 
own item number, and you can keep track of how many ribbed shirts you have.  Scroll through the Group 
Name list by using the cursor keys (<←←←←>, <↑↑↑↑>, <→→→→>, <↓↓↓↓>) or by clicking on the up and down arrows with 
your mouse.  Once the desired group name is highlighted, select it by either pressing <TAB> or clicking on 
the next field with the mouse.  NOTE:  The group name must first be added through Group Maintenance 
in the Inventory  menu.  For more information on adding group names, see Chapter 2: Inventory Control 
– Inventory Menu – Group Maintenance. 
 
Size: This is the size of the item.  If you have an item that comes in different sizes (such as Small, Medium, 
and Large), you can use this field along with a group name to create a different item number for each size. 
 
Color: This is the color of the item.  If you have an item that comes in several colors (such as Black, White, 
and Blue), you can use this field along with a group name to create a different item number for each color. 
 
This function also allows you to select which modifiers will be displayed when the item is added to an 
invoice. 
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To select an item as a modifier for another inventory item: 
 

• Use <TAB> or the mouse to move the cursor to the Inventory List , then use <↑↑↑↑> and <↓↓↓↓> or the 
mouse to highlight the modifier item you wish to add to the Modifier List . 

 
• Once the item is highlighted, click on Add to add the item to the Modifier List .  Repeat this for 

every item you want to add as a modifier. 
 

• To remove an item from the Modifier List , use <TAB> or the mouse to move the cursor to the 
Modifier List , then use <↑↑↑↑> and <↓↓↓↓> or the mouse to highlight the modifier item you wish to 
remove.  Once the item is highlighted, click on Remove. 

 
Rental/Used 
 
To access the Rental and Used page, click on the Rental/Used tab or press <ALT+R> .  If setting up 
rental products, we recommend using the Rental Manager. 
 

 
 
# Days Rent: This is the number of days the item can be rented for without incurring any late charges.  The 
maximum number of digits is two. 
 
Daily Late Charge: This is how much the customer will be charged per day once the item is overdue. 
 
Rating: This is the rating of the movie (Example: G, PG, PG-13, R, or NC-17). 
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Item Approval Code:  This field is for informational purposes only.  You may enter an item approval code 
for a rental item in this field. 
 
Actor Name:  If the rental item is a movie, you may enter the leading actor’s name in this field. 
 
Actress Name: If the rental item is a movie, you may enter the leading actress’ name in this field. 
 
Link to Sell-Through Item Number:  If you have set up an item in inventory maintenance as rental and 
now wish to switch to the rental maintenance system, then you may link your old items by putting the 
sellthrough number here. 
 
Used in Stock:  The quantity for this item that you have in stock, used. 
 
Used Cost:  This field may be used either as the trade in value or to get the average amount that the used 
items in stock have cost you.   This is set in options. 
 
Used Max:  Attempting to go above the quantity set in this field will prompt the cashier that there may be 
too many in stock already. 
 
Used Price 1:  Amount to charge for this item used in condition 1. (Complete) 
 
Used Price 2:  Amount to charge for this item used in condition 2.  (Incomplete) 
 
Trade In Price 1:  Amount to offer in store credit for this item in condition 1.  (Complete) 
 
Trade In Price 2:  Amount to offer in store credit for this item in condition 2.  (Incomplete) 
 
Trade In Price 1 (Cash):  Amount to offer in cash for this item in condition 1.  (Complete) 
 
Trade In Price 2 (Cash):  Amount to offer in cash for this item in condition 2.  (Incomplete) 
 
Whether to use Trade In Price fields or the Used Cost field is set in the Used/Trade In Options menu.
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Printers 
 
To access the Printers page, click on the Printers tab or press <ALT+P> . 
 

 
 
This function allows you to select which printer(s) an item will print on and/or which monitor(s) an item 
will be displayed on.  For example, if a customer orders a Coke and a hamburger, you can print the soda 
order at the bar at COM1 and the hamburger at the grill at COM2. 
 
Add Monitor:  Use this button to send an item to a monitor at a specified Station ID instead of (or in 
addition to) a printer.  The order can then be displayed on the selected station by choosing Order Filling  
from the File menu on the Restaurant ExtremePOS Login Screen. 
 
Add LPT Port:  Use this button to select an LPT port for the item. 
 
Add COM Port:  Use this button to select a COM port for the item. 
 
Add Port Address: Use this button to specify a networked port address (ex: //server/hp4000) for an item.  
This allows for much greater flexibility in printer placement and setup for restaurant environments. 
 
Remove Port: Use this button to remove a networked port address from the list of printers. 
 
NOTE:  You can choose to print to any printer that is setup on your system, including local and network 
printers.  Even if you don’t choose a printer, a receipt will print to the default printer if Print Invoices is set 
to YES in the Options screen. 
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Sales History 
 
To access the Sales History page, click on the Sales History tab or press <ALT+H> . 
 

 
 
This screen displays all of the invoices on which the selected item was sold.  It displays the Invoice 
Number, Date, Time, Customer Number, Quantity, Cost, and Price.  You may select new or used to view 
the history of to the left. 
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Inventory Tools 
 
To access the Inventory Tools page, click on the Inventory Tools tab or press <ALT+T >. 
 

 
 
Instant PO: This allows you to generate an instant purchase order for the item. 
 
Reorder Report: This report displays a list of inventory items that have fallen below their respective 
reorder levels, separated by department.  The report contains the following information about each item: 
Item Number, Item Name, Department Number, Vendor Number, Vendor Name, Part Number, Cost, In 
Stock, Value, Price, Reorder Level, and Reorder Quantity. 
 
View Defaults:  This allows you to view your station defaults when setting up new items.  It allows you to 
save time when entering repetitive fields for similar items. 
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Extreme Import from Vendor Data:  This allows you to import vendor database records to view and 
ultimately assist in setting up inventory records in your database file. 
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Control Buttons 
 

 
 
Add:  This will add the item to your inventory.  NOTE: Once an item has been added to your inventory, 
you cannot change the item number and it can only be deleted if it hasn’t been used in a previous 
invoice.  However, you can edit the item name. 
 
Update: This will save any changes made to the current item. 
 
Duplicate: If you have more than one of a particular rental item, you can use Duplicate to copy all of the 
information from one item number to a new item number.  This allows you to have the same information on 
more than one rental item without manually entering the information for each one. 
 
Delete: This will delete the current item from your inventory.  NOTE:  An item can only be deleted if it 
hasn’t been used in a previous invoice. 
 
Cancel:  Click on this button to cancel the current data entry. 
 
Exit:   Click on this button to exit the Inventory Maintenance Screen. 
 

 
 
Use the arrow Previous and Next buttons to scroll through your inventory item.  The Previous button  will 
display the previous item and the Next button will display the next item. 
 
To search for an item, type the item number or item name in the Search by Item Number or Search by 
Item Name field, or click on the down arrow to display a list of all the inventory items. You can also use 
the up and down arrows, <↑↑↑↑> and <↓↓↓↓>, to scroll through the inventory when that field is highlighted. 
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Rental Maintenance 
 

 
 

The Rental Maintenance screen provides an interface for quickly creating and managing rental pieces.  
Rental Maintenance can be accessed by selecting View -> Rentals from the menu on the Invoice screen.  
There are 3 tabs on the Rental Maintenance screen which provide the capability to add, retire and link rental 
copies to a sell through item number. 
 
There are some common components to the Rental Maintenance screen which we’ll discuss first. 

1. Sell Through Item Number.  This box displays the currently selected sell through item number.  
The title for the selected item is displayed to the right of the box.  A valid sell through item must 
be selected before you can Add, Retire or Link rental copies.  You can select a sell through item by 
either scanning or searching for the item as described below. 

2. Scan Button.  Hitting the Scan Button will display an input window as shown below.  Scan in (or 
type) the desired sell through item number in the text box and hit OK.  Selecting Cancel from the 
input window will return you to the rental maintenance screen without selecting a sell through item 
number. 

 
3. Search Button.  Selecting the Search Button will bring up the Extreme Lookup screen where you 

can search for the desired sell through item.  After you find and select the item within the Extreme 
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Lookup screen, you will be returned to the Rental Maintenance screen.  Please refer to the Extreme 
Lookup screen section in this manual for more information on searching for  and selecting items. 

4. Copies Grid.  The Copies Grid contains information about all rental copies associated with the 
selected sell through item.  This includes the barcode number of each copy, item name, rental 
status, customer (if rented), due date (if rented), days rented, dept, category, etc. 

5. Change Rental Data Button.  Selecting this button brings up the Rental Data Entry screen shown 
below.  If copies already exist for this sell through item, the initial values for the rental data will 
default to the existing data.  Modify any of the fields as desired and select OK to make the changes 
to all copies of the selected sell through item.  Selecting Cancel will return you to the Rental 
Maintenance Screen without changing the data. 

 

 
 

6. Exit Button .  Selecting this button closes the Rental Maintenance Screen. 
7. Print Label Button .  Selecting this button will print a barcode label for the rental copy currently 

selected in the Copies Grid. 
 
 
The 3 tabs located beneath the Copies Grid provide the capability to create and manage your rental copies.  
Each tab is discussed in more detail below: 
 

1. Add Copies Tab – This tab allows you to create copies of the selected Sell Through Item Number.   
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There are two ways to create copies, add them manually or autogenerate them.  If you want control 
over the item numbers for your copies, you will probably want to add them manually.  To add a 
copy, enter the item number in the Item Number box , select the desired barcode type and hit the 
Add Button.  To autogenerate copies, enter the number of copies to be generated in the # of Copies 
box and hit the Generate button.  In both cases, the new copy (or copies) will be added to the 
Copies Grid.  If you need to print barcode labels for the new rental copies, select the Print Labels 
check box prior to adding or autogenerating copies.. 

 
2. Retire Copies Tab – This tab allows you to retire (inactivate) rental copies when they are no 

longer needed.   
 

 
 
In order to retire a copy, you should enter the item number of the copy in the Item Number box, 
then select the Retire Button 

 
 

3. Link Copies Tab – This tab allows you to establish a link between an existing rental item and a 
sell through item.   

 

 
 
This function is primarily included for customers who have already created rental items through 
the inventory maintenance screen and wish to convert over to use the new rental management 
features.  To link a rental item, first select the desired sell through item as described earlier in this 
section.  Then enter or scan the item number of the rental item in the Rental Copy box and click on 
the Link Button to complete the link.  Selecting the Search Button will bring up the Extreme 
Lookup Screen so you can search for the rental item.   
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Return Rentals 
 

 
 

When a customer returns an item that has been rented, select Return Rentals from the Actions menu to 
return the item to the store.   
 
To return a rented item: 
 

• Select Return Rentals from the Actions menu or press <CTRL+F1>. 
 

• Type in the item number of the item being returned, then press <ENTER>. 
 
• EXTREMEPOS will display the Department, Item Number, Item Name, and Status of the 

returned item that was just entered. 
 
• Click on Exit  or press <ALT+X>  to exit. 
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Cost Markup Percentage 
 

 
This feature allows you to set the default price for an item as a certain percentage more than the cost of the 
item.  When adding the item to the inventory, the price will default to the cost markup percentage.  The 
default price may be changed at any time.  To set a value for the Cost Markup Percentage, select Cost 
Markup Percentage from the View menu.  Type in the desired percentage then click on OK  or press 
<ENTER>.  For example, if you want to set the cost markup percentage at 50%, you should type 50, not .5.  
Click on Cancel to quit without selecting a percentage. 
 
 

Inventory/Kit Sort Order 
 

 
This function allows you to sort your inventory items and kits by either item name or by item number.  To 
sort your inventory by item name, click on Inventory/Kit Sort Order  in the Inventory  menu then select 
Sort by Item Name, or press <SHIFT+F7> in the Invoice Screen.  To sort your inventory by item number, 
click on Inventory/Sort Order  in the Inventory  menu then select Sort by Item Number, or press 
<SHIFT+F8> in the Invoice Screen.  A check will appear next to the current manner of sorting inventory. 
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Group Maintenance 
 

 
A group is a way to classify an item that has different styles. Group Maintenance allows you to create 
groups for inventory items. 
 
To create a new group: 
 

• Select Groups from the View menu. 
 

• Click on Add or press <ALT+A> .  Type in the new group name.  The group name can can contain 
any alphanumeric characters.  Click on OK  or press <ENTER> to create the group.  Click on 
Cancel to quit without creating a group. 

 
When you highlight a group in the Select Group list, all of the sizes and colors available for the group will 
be displayed in the grid.  Click on a cell in the grid to display information about that item.  The item 
number, description, and current quantity in stock will appear in the General Tab.  The On Order  tab 
displays any open purchase orders for the selected item.  
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Group Maintenance also allows you to generate and receive purchase orders for group items. 
 
To generate a purchase order for an item: 
 

• Double-click on the desired item.  Enter the amount that you would like to place on order then 
click on OK  or press <ENTER>. 

 

 
 

• Click on Generate PO or press <ALT+G> .  The item will appear on the Purchase Order grid with 
the entered quantity.  Modify any fields that may need to be changed, then click on Create. 

 
To receive an item from an existing purchase order: 
 

• Click on the desired item to select it, then click on Receive from PO or press <ALT+R> . 
 

 
• Enter the quanity received, then click on OK  or press <ENTER>.  Your inventory will be 

updated. 
 
To receive an item that does not have an existing purchase order: 
 

• Click on the desired item to select it, then click on Instant PO or press <ALT+P> . 

 
• Enter the amount received and select a vendor (if any), then click on Receive or press <ALT+R> .  

Click on Exit  or press <ALT+X>  to quit without receiving any items. 
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Instant PO’s 

 
 
This feature allows you to generate an instant purchase order for an item.  You can use this function to add 
additional stock at a new cost and EXTREMEPOS will automatically calculate the average cost of this item 
if Average Cost Method is enabled in the Options Screen.  To generate an instant purchase order, select 
Instant PO’s from the Actions menu.  Enter the purchase order information then click on Receive or press 
<ALT+R>  to receive the purchase order.  Your inventory will automatically be updated.  Click on Clear or 
press <ALT+C>  to clear the entered information.  To quit without receiving the purchase order, click on 
Exit  or press <ALT+X> . 
 
Enter Item #: Enter the item number of the item being received here. 
 
Quanity Received: Enter the received quantity of the item here. 
 
Cost Per: Enter the cost per item in this field. 
 
Vendor: You may select a vendor for the purchase order here.  Select None if there is no preferred vendor 
for this item. 
 
Used: Check this box if you are receiving a quantity of used items. 
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Price Tables 
 

 
 
The price tables feature allows for you to set prices from a range of retail prices for different departments.  
For instance, you may set it up so that all items in the DVD department that retail from 12.99 to 14.99 are 
set at a price of 11.99 in your store.   Each department requires its own price table.  To set up a new table, 
hit New.  To edit an existing table, hit Edit.  To delete a table, hit Delete. 
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Kit Maintenance 

 
 

A kit  is a group of inventory items that is sold as one item.  Each kit will have its own unique kit number, 
but it is considered a group of inventory items.  Kits are a faster method of adding individual items of a 
group to an invoice.  When a kit is added to an invoice, all of the inventory items associated with that kit 
number will be automatically placed on the invoice.  You may also specify a price for the kit that is 
different than the total of all the prices of the included inventory items.  
 
The Kit Maintenance screen allows you to add items to your inventory as well as edit existing inventory 
items.  To access this screen, select Kits  from the View menu or press <SHIFT+F3> in the Invoice Screen. 
 
Once you have accessed the Kit Maintenance screen, you can use <TAB> or the mouse to move from one 
field to another.  To add a kit, click on Add or press <ALT+A> .  Enter the desired information, then click 
on Save or press <ALT+V>  to save the new item.  To update an item, change the desired information then 
click on Update or press <ALT+U> .  To exit without making any changes, click on Exit  or press 
<ALT+X> . 
 
NOTE:  Kit Number and Kit Name are required fields.  You MUST enter a kit number and kit name 
for each item. 
 
Search By:  This allows you to select the kit sort method.  You can choose ITEM ID  or ITEM Name. 
 
Search Kits:  This allows you to enter the ITEM ID or ITEM Name to find the item quickly depending on 
you chosen sort option. 
 
Department Search Description: This allows you to select a department for the kit.  Scroll through the 
Department list by using the cursor keys (<←←←←>, <↑↑↑↑>, <→→→→>, <↓↓↓↓>) or by clicking on the up and down arrows 
with your mouse.  Highlight the desired department, then press highlight the desired department.  NOTE:  
The Department must first be added through Add New Department under Departments in the View menu.  
For more information on creating departments, see Chapter 2: Inventory Control – Departments. 
 
Category Search Description: This allows you to select a department for the kit.  Scroll through the 
Department list by using the cursor keys (<←←←←>, <↑↑↑↑>, <→→→→>, <↓↓↓↓>) or by clicking on the up and down arrows 
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with your mouse.  Highlight the desired department, then press highlight the desired department.  NOTE:  
The Department must first be added through Add New Category under Category in the View menu.  For 
more information on creating departments, see Chapter 2: Inventory Control – Categories. 
 
Kit Number:  This is the unique identifier for the kit.  It can be up to 18 characters long and consist of any 
combination of letters and numbers.  However, if you are using barcodes, as is recommended, you may only 
use numbers in the kit number.  NOTE: Do not use any symbols, punctuation, or spaces, except for the 
underscore (_), as part of the item number. 
 
Kit Name: This is the description of the kit that will appear on invoices and reports.  It can be up to 30 
characters long and consist of any upper and lower case letters, numbers, punctuation, or spaces.  NOTE: 
Do not use the asterisk (*) as part of the item name. 
 
Calc Cost Per: This is the calculated total cost of all the inventory items in the kit.  This is a read-only 
field.  You cannot enter information in this box. 
 
Calculated Price: This is the calculated price of the individual inventory items together in the kit.  This is 
a read-only field.  You cannot enter information in this box. 
 
Price Override: This is the price that will override the calculated price for the kit.  Even if the prices of the 
individual items change, the price override will remain the same.   
 
Tax: This indicates which tax(es) should be charged to this item.  Click on the box next to the desired tax 
level(s) to choose the type of tax to be applied to this item.. 
 
Search Inventory: This is where you enter the item name or item number of the items that will be part of 
the kit.  You may scan or type in this information.   
 
Kit Grid:  Once an item has been added to the kit, it will appear in the Kit Grid .  The grid displays the item 
number, item name, quantity, discount, price, and cost of the items included in the kit. You may change the 
quantity and specify a discount price for an item, but the Price Override will take precedence over the 
discounted calculated price.  
 
To create a kit: 
 

• Click on Add or press <ALT+A> . 
 

• Select the desired department, enter a kit number and kit name, then enter the price override.  You 
may use <TAB> or the mouse to move between fields.  NOTE:  You must enter a kit number 
and a kit description.  Department selection and Price Override are optional fields. 

 
• Add items to the kit grid by scanning or typing in the inventory items items or select an item from 

the pull down menu.  Once an item is added, it will appear in the Kit Grid.  You may change the 
quantity or enter a discount price for each item in the grid at any time.  Repeat this for each item in 
the kit. 

 
• To delete an item from a kit, position the cursor on the desired item, then press <CTRL+DEL> . 

 
• Once you have finished entering all the items in the kit, click on Save or press <ALT+V>  to add 

the kit to your inventory.  Click on Cancel or press <ALT+C>  to quit without adding the kit. 
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Control Buttons 
 
Add:  This button adds the kit to your inventory.  NOTE: Once a kit has been added to your inventory, 
you cannot change the kit number and it can only be deleted if it has never been sold.  However, you 
can edit the kit name. 
 
Delete: This will delete the current kit from your inventory.  NOTE:  A kit can only be deleted if it hasn’t 
been used in a previous invoice. 
 
Update: This will save any changes made to the current kit. 
 
Sales Summary: This will display a summary of sales per month of the current year for the kit.  The 
summary will display the total sales, cost, and quantity for each month. 
 
Next and Previous: These buttons allow you to scroll through your kits.  Next will display the next kit 
while Previous will display the preceding kit. 
 
Exit:  Click on this button to exit without adding or updating a kit. 
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Non-Inventory Item 
 

 
This feature allows you to add an item to an invoice that is not part of your inventory.  To access this 
screen, select Non-Inventory Item from the Invoice menu or press <CTRL+N>  in the Invoice Screen.   
 
To add a non-inventory item to an invoice: 
 

• Enter the description, cost, quantity, and price of the non-inventory item.  Click on the box next to 
the desired tax level(s) to choose the type of tax to be applied to this item.  If Auto Cost % is set 
to Yes in the Options Screen, EXTREMEPOS will automatically calculate the cost once the price 
of the non-inventory item is entered. 

 
• Click on Add To Invoice or press <ALT+A>  to add the item to the invoice.  Click on Cancel or 

press <ALT+C>  to quit without adding the item to the invoice. 
 
 
 

Print Ticket/Voucher 
 

This feature allows you to print additional tickets or vouchers for an item.  You must enter the 
administrator password before printing additional tickets or vouchers. 
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Display Back Orders (Legacy) 

 
 

(This feature was obsoleted in 2.6 by the Special Orders feature; it is left in the manual for reference of 
users of older versions.) 
 
This screen displays either the items that are currently on backorder for a selected customer or the 
customers for whom a particular item is on backorder.  The grid displays the date the backorder was placed, 
customer number, item number, item name, the quantity placed on backorder by the customer, the current 
quantity in stock, amount paid, whether or not the backorder was prepaid, and the invoice number.  To 
access this screen, select Backorders from the View menu. 
 
To view items on backorder for a customer: 
 

• Type the desired customer number in the For Customer # field. 
 

• Press <TAB> to move the cursor to a new field.  Only backorders for the entered customer will be 
displayed. 

 
To view which customers have placed a certain item on backorder: 
 

• Type the desired item number in the For Item # field. 
 
• Press <TAB> to move the cursor to a new field.  Only backorders for the entered item will be 

displayed. 
 
There are three options for displaying backorders.  Select All Open Backorders to display all backorders 
that have not yet been filled.  Select Backorders Covered by Stock to only display backorders for items 
that are currently in stock.  Select Backorders Not Covered by Stock to only display backorders for items 
that are not in stock. Select Backorders Not Covered by Stock nor by PO to only display backorders for 
items that are not in stock or covered by incoming purchase orders. 
 
To fill a backorder, double click on the desired backorder or highlight the desired backorder then click on 
Fill Backorder  or press <ALT+F> .  The item will be added to the current invoice.  Click on Exit  or press 
<ALT+X>  to exit without filling a backorder.  Click on Delete to erase a backorder without filling it. 
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Special Orders/Preorders 

 
 

This screen displays items that are either preordered or on special order for customers. 
 
You may filter the displayed items by the radio buttons on the lower left-hand side.  All Open Special 
Orders will display all special orders not yet filled.  All Open Special Orders for Current Customer will 
display all special orders not yet filled for the customer currently selected on the invoice screen.  Special 
orders covered by Stock will display those orders not yet filled that can be filled by inventory currently in 
stock.  Special orders NOT covered by Stock will display the orders not yet filled that cannot be filled 
from current inventory.  Special orders NOT covered by Stock nor by PO will display orders than cannot 
be filled from current inventory or from open purchase orders. 
 
Add to Invoice will attempt to pick up the selected item, automatically selecting the reserving customer.  
Cancel will cancel the reservation and place a refund for the customer’s money on the invoice. 



Chapter 3: Inventory Control 
 

ExtremePOS 78 

  

Departments 
 

 
Department Maintenance 
 

 
 
The Department Maintenance screen allows you to create or update departments. To access this screen, 
select Departments from the View menu, and then select Departments. 
 
Important Note:  Do not delete the department called “None”.  Some functions in eXtremePOS 
require the presence of this department. 
 
To create a department: 
 

• Click on Add or press <ALT+A> . 
 
• Type in the new department ID in the Department ID field.  NOTE:  Do not use an asterisk, *, 

in the Department ID. 
 

• Use <TAB> or the mouse to move the cursor to the Department Description field, then type in 
the description of the new department. 

 
• Click on the Department Type.  Select Rental to create a rental item department.  Select 

Employee to create an employee department.  Select Regular for all other types of departments. 
 

• Click on Save or press <ALT+S> to add the department.  Click on Cancel or press <ALT+C>  to 
quit without creating a department. 
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To update or delete a department: 
 

• Select the desired department.  Scroll through your departments by using the Previous and Next 
buttons.  The Previous button will display the previous department and the Next button will 
display the next department.  To search for a department, type the department name or 
department number in the Search by Dept ID or Search by Dept Description field, or click on 
the down arrow to display a list of all the departments.  Once this field is highlighted, you can 
also use the up and down arrows <↑↑↑↑> and <↓↓↓↓> to scroll through the list. 

 
• Change the desired information, then click on Update or press <ALT+U> .  Click on Exit  or 

press <ALT+X>  to quit without saving any changes. 
 

• To delete the selected department, click on Delete or press <ALT+D> .  All of the items in the 
deleted department will show a blank department field so we strongly suggest NOT to delete a 
department once it has been created and assigned to existing inventory items. 
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Categories 
 

 
Category Maintenance 
 

 
 
The Category Maintenance screen allows you to create or update categories. To access this screen, select 
Categories from the View menu, and then select Categories. 
 
Important Note:  Do not delete the category called “None”.  Some functions in eXtremePOS require 
the presence of this category. 
 
To create a category: 
 

• Click on Add or press <ALT+A> . 
 
• Type in the new category ID in the Catagory ID field.  NOTE:  Do not use an asterisk, *, in the 

Category ID. 
 

• Use <TAB> or the mouse to move the cursor to the Category Description field, then type in the 
description of the new category. 

 
• Click on Save or press <ALT+S> to add the department.  Click on Cancel or press <ALT+C>  to 

quit without creating a department. 
 
To update or delete a category: 
 

• Select the desired category.  Scroll through your categories by using the Previous and Next 
buttons.  The Previous button will display the previous category and the Next button will 
display the next category.  To search for a category, type the category name or category number 
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in the Search by Category ID or Search by Category Name field, or click on the down arrow 
to display a list of all the categories.  Once this field is highlighted, you can also use the up and 
down arrows <↑↑↑↑> and <↓↓↓↓> to scroll through the list. 

 
• Change the desired information, then click on Update or press <ALT+U> .  Click on Exit  or 

press <ALT+X>  to quit without saving any changes. 
 

• To delete the selected category, click on Delete or press <ALT+D> .  All of the items in the 
deleted department will show a blank department field. 
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Vendors 
 
This menu displays the different options dealing with vendors.  A vendor is a person or company from 
whom you purchase items in your inventory. 
 
Vendor Maintenance 
 

 
 
This function allows you to create a new vendor.  To access this screen, select Vendors from the View 
menu. 
 
To create a vendor: 
 

• Click on Add or press <ALT+A> . 
 
• Type in a vendor number in the Vendor Number field.  You may wish to use an account number 

as a vendor number.  NOTE: Do not use an asterisk, *, in the vendor number. 
 

• Use <TAB> or the mouse to move the cursor to each field to enter the vendor’s information, then 
click on Save or press <ALT+S> to add the vendor.  Click on Cancel or press <ALT+ C>  to quit 
without creating a vendor. 
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To update or delete a vendor: 
 

• Select the desired vendor.  Scroll through your departments by using the Previous and Next 
buttons.  The Previous button will display the previous department and the Next button will 
display the next department.  To search for a vendor, type the vendor name or vendor number in 
the Search by Vendor Number or Search by Vendor Name field, or click on the down arrow 
to display a list of all the vendors.  Once this field is highlighted, you can also use the up and 
down arrows <↑↑↑↑> and <↓↓↓↓> to scroll through the list. 

 
• Change the desired information, then click on Update or press <ALT+U> .  Click on Exit  or 

press <ALT+X>  to quit without saving any changes. 
 

• To delete the selected vendor, click on Delete or press <ALT+D> .  NOTE:  Only vendors that 
are not preferred vendors for an item may be deleted. 
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Purchase Orders 
 

 
 

The Purchase Orders screen allows you to create and update purchase orders.  To access this screen, select 
Purchase Orders from the Actions menu, or press <CTRL+P> in the Invoice Screen. 
 
The main screen displays all open purchase orders: 
 
PO #: This is the purchase order number.  It is assigned by EXTREMEPOS after the purchase order is 
created and cannot be modified. 
 
Date: This is automatically set to the current date.  It cannot be modified. 
 
Ref #: This is an optional field and is assigned by the user. 
 
Vendor #: You must select a vendor number for each purchase order.  This is the vendor from whom you 
are purchasing the order. 
 
Due Date: You must enter a due date for each purchase order.  This is the date by which the order should 
be received.  It should be in the format MM/DD/YYYY . 
 
Status: This is the current status of the purchase order: O-open purchase orders, C-closed purchase orders, 
or V-voided purchase orders. 
 
Total Cost: This is the total cost of the order.  It is automatically calculated by EXTREMEPOS and cannot 
be modified. 
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To create a purchase order: 
 

• Click on Add or press <ALT+A>,  then enter the desired information: 
 

• Once all of the information has been entered, click on Save or press <ALT+S> to save the 
purchase order.  Click on Cancel or press <ALT+C>  to quit without saving the new purchase 
order.  You will be asked if you would like to print a copy of the purchase order after saving it. 

 
To update a purchase order: 
 

• Click on the desired purchase order and then click Edit . 
 

• Click on Update or press <ALT+U>  to save your changes.  Click on Cancel or press <ALT+C>  
to quit without making any changes. 

 
To close a purchase order: 
 

• Double-click on the desired purchase order. 
 

• Click on Close or press <ALT+L>  to close the current purchase order.  Click on Cancel or press 
<ALT+C>  to quit without closing the purchase order.  NOTE: Closed purchase cannot be 
reopened. 

 
General Information 

 
Select Vendor: You must select a vendor for each purchase order.  This is the vendor from whom you are 
purchasing the order.  Use the mouse to click on the desired vendor. 
 
Due Date: You must enter a due date for each purchase order.  This is the date by which the order should 
be received.  Due Date should be entered in the format MM/DD/YYYY . 
 
Ship Via: This is an optional field and is assigned by the user.  It is the method by which the order is being 
shipped (Example: UPS Ground, Fed Ex Overnight, etc.). 
 
Reference #: This is an optional field and is assigned by the user. 
 
Terms: This is an optional field.  It is automatically entered if there are terms present for the vendor.  The 
user can override this information.  (Example: Net 30) 
 
Ship To: This is an optional field and the user may modify it.  The default Ship To Address is the address 
located in the Company Information screen.  You may add additional lines for Attn:, phone number, etc. 
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Add Items 

 
 
 
To add items to a purchase order, you may either scan or enter the item number you wish to add into the 
item number field, followed by the quantity desired when prompted, or you may use the lookup or BO items 
tools. 
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This screen works much like the other lookup screens in the software, in that you may show all of your 
inventory items, quick search by item number, or do an advanced search.  The advanced search offers 
several powerful tools for your purchase orders. 
 

 
 
You may search by item name, by vendor, or by one of several other fields, and by up to three of these at 
any one time.  This allows you to find, for example, all games with the name of Madden that you have set 
with VPD as a vendor, or all King James Bibles you get from Spring Arbor. 
 
Additionally, you may search for only items that are below the reorder level you have set by checking the 
Below Reorder Point box.  You may modify your in-stock amount for this calculation by using the 
Consider Used in Stock, which will add your used stock to your new, and by Consider Open PO’s, which 
will count items ordered in open purchase orders. 
 
Once you have searched, you may individually select items to add to the purchase order, followed by a 
quantity, or you may select all in which case the quantity will default to what you have set as the Reorder 
Quantity number on that item’s inventory screen.  You may modify it on that screen by clicking the quantity 
field of the line you wish to modify and typing in the quantity you want. 
 
In order to check Special Orders to see what customers have on hold, click BO Items.  It will bring up the 
following screen: 
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To add an item to the PO from this screen, click it in the grid and hit Add to P.O.  Enter the quantity you 
want to order.  Click Add to Invoice to finish the special order, Cancel to remove it without filling it, or 
Exit  to return to the PO screen. 
 
To receive items on a purchase order: 
 

• Double-click on the desired purchase order. 
 

• To receive one item on the purchase order, click on Receive Item or press <ALT+I> .  To receive 
all of the items on the purchase order, click on Receive All or press <ALT+A> . 

 
• If you choose to receive a single item, you will be prompted to enter the line number of the item to 

receive.  Enter the desired line number then click on OK  or press <ENTER>. 
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• Next you will be prompted to enter the quantity received of that item.  Enter the received amount 
then click on OK  or press <ENTER>. 

 

• Click on Update or press <ALT+U>  to update the purchase order and the inventory. 
 
 
To print a purchase order: 
 

• Click on the desired purchase order. 
 

• Click on View/Print . 
 

• To print while editing a purchase order, click Print  or press <ALT+P> . 
 

Control Buttons 
 
Add:  This creates a new purchase order. 
 
Update: This updates any changes made to the displayed purchase order. 
 
Close: This closes the displayed purchase order.  NOTE: Closed purchase orders cannot be reopened. 
 
Cancel: This exits the edit mode without saving any changes made. 
 
Exit: Click on this to exit the Purchase Orders screen. 
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Online Ordering 
 
 There currently are two online ordering systems integrated into the software:  Ingram and EDI.  
Each allows the ability to place product orders in minutes and is highly customizable.  An added option for 
Ingram orders is the ability to save and restore configurations for future orders. 
 
Ingram Ordering (Praiz Only) 
 

 
 
 Set options for Ingram/Spring Arbor ordering here 
 
Allow Split Line Orders:   This option sets whether Split Line Orders will be permitted for this order.  A 
checked box allows Split Line Orders.  A blank box disallows Split Line Orders. 
 
Participate in GreenLight Program:   This option places the order in the GreenLight program.  For further 
information involving the GreenLight program contact Ingram. 
 
Hold Back Orders:  This option, if checked, will cause the order to be held until back orders are filled.  
Unchecked, the order will be sent out without waiting for back ordered items. 
 
Allow DC Pairs:  This option enables or disables the use of DC Pairing for the order. 
 
Order Type:  This drop down list allows the selection of order type.  Changing of this option is not 
required for normal operation. 
 
Warehouse:  This drop down list determines from which warehouse the order will be shipped.  An 
additional warehouse may be entered manually if not found in the list.  Changing of this option is not 
required for normal operation. 
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Shipping Type:  This drop down list determines the method of shipping for the order.  Changing of this 
option is not required except for normal operation.  NOTE:  Currently Unavailable.  
 
Back Order:  This drop down list determines what action will be taken in the event of a back order on one 
or more items in the order. 
 
Do Not Ship Before Date:  This option instructs Ingram to not ship the order until the specified date.  
 
Back Order Cancel Date:  This option instructs Ingram to cancel any back orders on the specified date. 
 
Customer Communication:  This text field allows for any further information or special instructions to be 
sent with the order. 
 
Send Order:  This button sends the current order to Ingram.  Ensure all settings are set appropriately 
beforehand.  This action requires several minutes to send and then receive confirmation from Ingram.  An 
acknowledgement screen will be displayed upon success. 
 
Retrieve POA:  This button will be enabled if an order was sent and has not yet received an 
acknowledgement.  Clicking this button will attempt to retrieve the acknowledgement from Ingram. 
 
View POA:  This button will allow the review of a received order acknowledgement.  If no such 
acknowledgement is available the button will be disabled. 
 
Reset to Default:  This button restores the available settings to the currently defined default values. 
 
Set As Default:  This button saves the currently selected settings, with the exception of Customer 
Communication, for use with other Orders. 
 
 
To Order Online via Ingram: 
 

• Double click on the desired purchase order or create a new purchase order. 
 
• Click on the Ingram Tab. 

 
• Select desired Ingram order options. 

 
• Click Send Order button and wait for operation to complete. 

 
• Upon successful completion of the order process the acknowledgement will be displayed. 
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AEC EDI Ordering 
 

 
 
Allow Backorders:  This option determines whether backorders will be allowed for this order.  A checked 
box allows for backorders.  A blank box disallows backorders. 
 
Special Order:  This option sets the order as a “Special Order”.  A checked box flags the order as special.  
A blank box represents a normal order. 
 
Special Instructions:  Any special instructions for the current order may be typed here.  A maximum of 
two (2) special instructions may be entered.  These fields may be left blank. 
 
Create Order:  This button creates the order file and saves it to disk where it can then be sent to AEC EDI 
immediately or any time in the future.  Make all option selections before using the Create Order action.  
NOTE:  EXTREMEPOS only creates the order.  It does not send the order to AEC EDI. 
 
View Order Folder:   This button will open the folder where created order files are stored. 
 
To Order Online via AEC EDI: 
 

• Double click on the desired purchase order or create a new purchase order. 
 
• Click on the AEC EDI Tab. 

 
• Select desired order options. 

 
• Click Create Order button and wait for operation to complete. 

 
• Upon successful completion of the order file creation process the output folder will be displayed
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Customer Menu 
 

Every transaction in ExtremePOS uses a specific customer, and each customer must have a customer 
number.  The default customer is Customer #101 (Cash Customer).  Businesses who are running a cash 
business, such as a convenience store, that don’t need to store customer names or addresses should use 
Customer #101.  However, stores such as video stores or restaurants may want to keep their customers’ 
names, addresses, and telephone numbers on file.  These stores should use the Customer Menu to add and 
edit customers.  To access the Customer Menu, click on View in the Menu Bar or press <F3>. 
 
NOTE: The Cash Customer is a necessary customer to have. Do not edit this customer.  If this customer 
gets edited or in any way deleted, you must replace it by running the Check Database utility in the File 
menu of the Login Screen (See Chapter 1: Setting Up ExtremePOS). 

 
Customer Maintenance 

 
 

Customer Maintenance allows you to create and update customer numbers for a customer.  To access this 
screen, select Customers  from the View menu or press <F3> in the Invoice Screen. 
 

Once you have accessed the Customer Maintenance screen, you can use <TAB> or the mouse to move 
from one field to another.  To add a customer, click on Add or press <ALT+A> .  Enter the desired 
information, then click on Save or press <ALT+V>  to save the new customer.  To update a selected 
customer, change the desired information then click on Update or press <ALT+U> .  To exit without 
making any changes, click on Exit  or press <ALT+X> . 
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General Info 
 

The General Info screen displays all the general information about a customer, such as name, address, and 
phone number.  To access this screen, click on the General Info tab or press <ALT+G> . 
 

Customer Number: This is the unique identifier for a customer.  Every customer MUST have a customer 
number.  Customer #101 is the default cash customer and cannot be changed.  Customer numbers can be up 
to 10 digits long and can contain any alphanumeric characters.  Some common customer numbers are phone 
numbers or a zip code followed by the first three letters of the customer’s last name.  NOTE: Do not use 
any punctuation or spaces, except for the underscore (_), as part of the customer number. 
 

Discount Level: This is the selected discount level for the customer.  Click on the arrow to drop down the 
box for more choices.  The default discount level is “A”.  The discount levels correspond to the levels 
specified under the Setup menu.  Each time an inventory item is selected for a customer invoice, the price 
will be based upon the customer’s discount level.  NOTE:  You can override Setup discount levels for an 
inventory item. 
 

Tax Exempt (Y/N): This indicates whether or not the customer is tax exempt.  If a customer is tax exempt, 
click on the box to put a check in it.  If the customer is not tax exempt, leave the box empty. 
 
Ship To Info:  These fields allow you to enter a shipping address for the customer. 
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Account Info 

 
 
The Account Info screen displays all the information about a customer’s account. To access this screen, 
click on the Account Info tab or press <ALT+C> . 
 
Customer Balance: This is the current on account balance for the customer. 
 
Open Account Date: This is the date that the customer’s account opened.  A customer with an open 
account may pay for invoices On Account.  To open an account for a customer, click on the O to the right 
of the Open Account Date field.  The current date will appear in the Open Account Date field.  You may 
also manually enter an open account date if it is differerent than the current date. 
 
Close Account Date: This is the date that On Invoice payment for the customer was terminated.  To close a 
customer’s account, click on the C to the right of the Close Account Date field.  The current date will 
appear in the Close Account Date box.  You may also manually enter a close account date if it is different 
than the current date. 
 
Max Balance: This is the maximum amount a customer may charge to their account.  If Max Balance is 
enabled in the Options Screen, customers will not be allowed to charge any amount on their account greater 
then their max balance. 
 
Credit Card:   You may set information about the customer’s preferred credit card here.  
 
Type:  The type of credit card the customer uses. 
 
Credit Card Number:  The number of the card.  In the database, this is stored as an encrypted number. 
 
Credit Card Expiration:  The expiration date of the card. 
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Member Bonus Plan: If a Customer Bonus Plan is activated, this indicates whether the customer is a 
member. Click on the box to enroll the customer in the plan.  Leave the box empty if the customer is not a 
bonus plan member. 
 
Membership Expiration Date: This is the date when the customer’s club membership expires.  This date 
bears no relation to On Account info or the Bonus Points Plan. 
 
Bonus Points Achieved: This is the current number of bonus points that the customer has accumulated for 
the bonus plan. 
 
Authorized Members:  Enter all members that are authorized to charge on account under this customer. 
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Extended Info 
 

 
 
The Extended Info screen displays additional info about the current customer. 
 
Customer Types displays information about the types assigned to this customer.  You may set it through 
the Assign Customer Types… button. 
 
Notes contains miscellaneous notes on the customer, and may be filled out by the user. 
 
User Defined Data 1 and 2 are fields for custom uses, defined by you. 
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Transactions 
 

 
 

 
 
To make a payment on an account: 
 

• Enter in the amount in the Amount field.  You can type any notes regarding the transaction in the 
Description field. 

 
• Select the type of transaction by either clicking on the description or the preceding circle.  Invoice 

Adjustment allows you to adjust the amount owed on a particular invoice.  Balance Adjustment 
allows you to directly change the customer’s balance.  Payment allows you to apply a payment to 
the account.  For Invoice Adjustments or Balance Adjustments, choose whether to Credit 
Account or Debit Account. 

 
• If applicable, choose the form of payment (Cash, Check, or Credit Card ). 

 
• If you make a mistake, you can click on Clear or press <ALT+L>  to clear any information that 

has been entered.  You can also click on Exit  or press <ALT+X>  to exit the Accounts 
Receivable screen. 

 
• Click on Apply Payment or Apply Adjustment  or press <ALT+A>  to apply the payment or 

adjustment.  If the form of payment is by check, you will be prompted to enter the check number.  
If the form of payment is credit card and no credit card information is entered in the Customer 
Maintenance screen, you will be prompted to enter the credit card number and expiration date. 

 
Date: This column shows the date that the transaction was completed.   
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Type: This column shows what kind of transaction was done.  ‘P’ indicates a payment and ‘A’ indicates an 
adjustment.   
 
Method: This column shows what kind of payment was made.  ‘CA’ indicates a cash payment, ‘CH ’ 
indicates a check payment, and ‘CC’ indicates a credit card payment.  ‘NA’ appears in this column for 
adjustments. 
 
Balance: This column shows the balance before the payment or adjustment was applied. 
 
Amount:  This column shows the amount for the payment or adjustment. 
 
Check #: This column shows the check number from a check payment. 
  
Inv#:  This column shows the invoice number of the invoice. 
 
Date: This column shows the date that the invoice was completed. 
 
Total:  This column displays the total price of the invoice, including tax. 
 
Balance Due: This column displays the remaining balance due on the invoice. 
 
Amt Applied:  This column displays the amount that has been applied to the invoice so far. 
 
 
Control Buttons 
 
Next and Previous: These buttons allow you to scroll through your customers.  Next will display the next 
customer while Previous will display the preceding customer. 
 
Add:  This creates a new customer number. 
 
Update: This updates any changes made to the customer information. 
 
Delete: This will delete the displayed customer number from your database. 
 
Exit:  Click on this button to exit from the Customer Maintenance screen.  All unsaved information will be 
lost. 
 
Search by Customer #/Last Name:  To search for a customer, type the customer number or last name in 
the Search by Customer # or Search by Last Name field, or click on the down arrow to display a list of 
all customers. You can also use the up and down arrows, <↑↑↑↑> and <↓↓↓↓>, to scroll through customers when 
that field is highlighted. 
 
Select for Current Invoice: Click on this box to select the current customer for the current invoice. 
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Change Customer Number 
 

 
This function allows you to change the customer number for any given customer.  To use this function, 
select Change Customer # from the Actions menu in the Customer Maintenance screen.  Enter the new 
customer number, then click on OK  or press <ENTER>.  Click on Cancel to exit without changing the 
customer number.  NOTE:  You cannot change the customer number for Cash Customer. 
 
Print Customer Labels 
 

 
 
Print Labels allows you to print labels for a customer on a supported label printer.  You can choose to print 
a label for the current customer, all customers, customers who satisfy a specified bonus point range, or 
customers who satisfy a specified event description and date range.  Each label has the customer number as 
a barcode and displays the customer name, address, city, state, and zip code.  To access this menu, click on 
Print Customer Labels in the Actions menu of the Customer Maintenance screen.  In order to select 
which records to print, look to the lower left portion of the screen at Select Records to Print.  To print a 
label for the current customer, select Current Customer.  To print a label for all customers, select All 
Customers.  To print a label for all customers who satisfy a specified bonus range, select Bonus Point 
Range.  You will be prompted to enter the lower and upper limits for the bonus point range.  To print a 
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label for all customers who satisfy a specified event date and description, select Event Range.  You will be 
prompted to enter an event description and the upper and lower limits for the event date range.  To include 
all event descriptions in your range, enter ‘*’  for the event description. 
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The Invoice Screen 

 
 
 

The Invoice Screen is where all of your daily invoicing will be done.  Administration tasks such as Reports, 
Accounts Receivable, Purchase Orders, Inventory Control are performed in different screens in 
ExtremePOS and are explained in other chapters. 
 
Before you begin processing invoices, you must manually enter your inventory items into EXTREMEPOS. 
You may want to enter just a few items at first so you can get a feel of how the program works, then 
progressively add more items.  Refer to Chapter 2: Inventory Control for more information on adding 
inventory items. 
 
Let’s take a more in-depth look at the key features of the invoice screen: 
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Dissecting the Invoice Screen 
 
 
Scan Item 
 

                   
 

Scan Item is the section of the Invoice Screen where you ring up the items that the customer wants to 
purchase.  To add an item to the current invoice, using your barcode scanner, scan the barcode of an 
inventory item you wish to sell.  Make sure the cursor is blinking in the Item Number box before you 
attempt to scan.  The item will then appear on the invoice grid if it is contained in your inventory.  If you are 
entering the number by hand, you must press <ENTER> after typing the number.   
 
If the quantity for an item you are adding to the invoice is different than one, you may change it prior to 
scanning or entering the item by pressing <ALT+Q > or clicking on the Quantity  box.  Note that the 
quantity can be negative and it does not need to be a whole number.  If the customer is returning an item, 
use a negative quantity.  This will add a negative amount to the current total as well as properly 
update the in-stock amount of the inventory item once the transaction is completed. 
 
Used 
 

                      
 
 
Used is the section for of the invoice screen to indicate whether the item about to be scanned in used.  It you 
are buying a used item from a customer then check the Trade-In  box.  You can have a “credit” or “cash” 
value for the trade-in.  You can also sell and buy different “conditions” of used items. 
 
Current Customer 
 
 

  
 
 
The default customer for each invoice is 101 Cash Customer.  You can also keep track of your customers 
by creating a customer number for each customer and then selecting it for the current invoice (Creating a 
customer is explained in detail in Chapter 3: Customer Control.  There are two ways to select a customer 
for an invoice, Quick Search and Lookup.  Quick Search allows you to select a customer by entering his 
or her number while Lookup allows you scroll through your customer records.  Details displays the 
customer number, discount level, and address of the current customer.    
 
To select a customer for the current invoice when you know the customer number: 
 

• Click on Quick Search. 
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• Type in the customer number, then press <ENTER> or click on OK .  You may also “scan” a 
customer barcode and find the customer instantly. 

 
• If the customer number is valid, that customer will appear in the current customer box. 

 
To select a customer for the current invoice when you don’t know the customer number: 
 

• Click on Lookup. 
 
• Click on Next or Previous (or use <ALT+N>  and <ALT+P> ) to scroll through the customer 

records. 
 
• Once the desired customer’s record is displayed, click on Select or press <ALT+L>  to select 

the customer. 
 
• Click on Exit  or press <ALT+X>  to exit without selecting a customer. 

 
 
Rental Return 
 

 

 
 
 
Rental is the section of the invoice where you can return a rental item, such as a video.  You can also 
display currently rented items and late rentals for the selected customer. 
 
Invoice Grid 
 

 

 
 
 
The Invoice Grid shows all of the items that are in the current invoice.  It is located in the middle half of the 
Invoice Screen.  The columns are resizable and movable.  If you make customer changes to the grid and 
want to make the change permanent, chose Tools>Save Grid Settings from the menu.  Scrolling to the 
right by clicking on the right arrow in the bottom right-hand corner of the grid reveals additional 
information about the item.    
 
If you need to change information on an invoice, press <CTRL+G>  to move the cursor to the invoice grid, 
then use the arrow keys to move to the line on the invoice you wish to change.  You may change various 
attributes of the item by using the selected item section, which will be discussed shortly. 
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Invoice 
 

  
 
 
The Invoice section is used to manipulate the entire invoice.  You have the ability to apply a discount 
globally to the invoice.  You can also put an invoice on hold and recall an on-hold invoice.   
 
 
Selected Item 
 

  
 
 
The Selected Item section is used to change a line item on the invoice grid.  Once you highlight the item in 
the invoice grid you would like to change, just click the button for the attribute you would like to alter. 
 
 
Totals 
 

  
 
 

Running totals are kept for the current invoice.  Each time you add a new inventory item to the invoice, the 
totals portion is updated.  If you are using a pole display, it will be updated as well. 
 
Subtotal: This line displays the total amount of all the items in the invoice added together before taxes or 
discounts. 
 
Discount %:  This line displays the discount percentage applied to an entire invoice.  This line only 
appears when the discount is applied to the entire invoice by selecting Invoice Discount from the Invoice 
menu or pressing <CTRL+D >.  
 
Discount Amount:  This line displays the amount of the discount being applied to the entire invoice. 
 
Disc Subtotal: This line displays the new Grand Total due to the invoice discount percentage.  
 
Tax: This line displays the total amount of tax for the invoice after any invoice discounts. 
 
Total:  This line displays the invoice total after taxes and invoice discounts.   
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Void:   This button will clear your entire invoice and start a new invoice without finalizing the transaction. 
 
End Transaction:  Choose this button to finalize the invoice and enter the payment information screen. 
 
 

Payment Information 
 

 
 
 
The Payment Information screen is where you will you will enter in the customer’s form of payment.  You 
have the option of using your mouse or keyboard.  To jump right to a payment type, use the <ALT>  and 
underlined letter in the payment type you seek.  For example, <ALT+H>  takes you to the Check form of 
payment.    
 
Split Tender allows a customer to pay for an invoice using two or more forms of payment.  To use split 
tender on an invoice, select Split Tender from the Invoice menu.  Select the forms of payment by clicking 
on the corresponding field or using the shorcut keys.  Press <ALT+C>  for cash, <ALT+H>  for check, 
<ALT+R>  for credit card, <ALT+A>  for on account, or <ALT+G>  for gift certificate.  Enter the amount 
using either the keyboard or the on-screen number pad.  Once you have made your selection, click on OK  
or press <ALT+O> .  You can click on Cancel or press <ALT+E>  to exit without choosing a form of split 
tender. 
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Invoice Menu 

 

 
 
 
 
The Invoice menu contains the options we have just discussed as well as many more.  This menu is only 
accessible when there is an invoice in progress.  To access this menu, click on Invoice in the Invoice Screen 
menu bar or press <ALT> release, then press I.   
 
Cash Payment 
 
To choose cash as the form of payment for an invoice, select Cash Payment from the Invoice menu or 
press <F6> in the Invoice Screen. 
 
Check 
 
To choose check as the form of payment for an invoice, select Check from the Invoice menu or press <F7> 
in the Invoice Screen. 
 
Credit Card 
 
To choose credit card as the form of payment for an invoice, select Credit Card  from the Invoice menu or 
press <F7> in the Invoice Screen. 
 
If you are using Express Manual Processing, you will not have to enter the card information into the 
software.  Make certain that it has been accepted by your third party processor before finishing the 
transaction. 
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On Account 
 
On Account allows a customer to put the invoice on his account.  Only customers who have an open 
account can choose this form of payment. To choose On Account as the form of payment for an invoice, 
select On Account from the Invoice menu or press <F9> in the Invoice Screen.  NOTE:  You cannot 
choose On Account as a form of payment for Cash Customer #101. 
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Split Tender 
 

 
 
Split Tender allows a customer to pay for an invoice using two or more forms of payment.  To use split 
tender on an invoice, select Split Tender from the Invoice menu.  Select the forms of payment by clicking 
on the corresponding field or using the shorcut keys.  Press <ALT+C>  for cash, <ALT+H>  for check, 
<ALT+R>  for credit card, <ALT+A>  for on account, or <ALT+G>  for gift certificate.  Enter the amount 
using either the keyboard or the on-screen number pad.  Once you have made your selection, click on OK  
or press <ALT+O> .  You can click on Cancel or press <ALT+E>  to exit without choosing a form of split 
tender. 
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Put Invoice On Hold 
 
This function allows you to place an invoice on hold and then enter new transactions.  Put Invoice On 
Hold could be used if the cashier began ringing up an order but then the customer realized that he forgot to 
pick up something on his list.  The cashier could place the invoice on hold and ring up other customers in 
line while the original customer gets the forgotten item.  To access this screen, select Put Invoice On Hold 
from the Invoice menu.  You will be prompted to enter an On Hold ID of up to 4 characters to use later to 
recall the invoice. 

 
 
NOTE:  To recall an on hold invoice, select Recall On Hold Invoice from the View menu.  You will be 
prompted to enter the Hold ID that you originally entered when you placed the invoice on hold. 
 
Print On Hold Invoice 
 
This function prints the invoice and puts it on hold.  You will be prompted to enter an On Hold ID of up to 
4 characters.  To use this function, select Print On Hold Invoice from the View menu. 
 
Void This Invoice 
 
This function allows you to void the current invoice.  To void the current invoice, select Void This Invoice 
from the Invoice menu. 
 
Invoice Notes 

 
 
Invoice Notes allow you to establish a personal relationship with each customer.  Additionally, such notes 
can be used to track specific information associated with an invoice.  These notes can be viewed whenever 
the invoice is recalled or reprinted.  To add a note to an invoice, select Invoice Notes from the Invoice 
menu.  You can type up to five lines with 42 characters each per note.  NOTE:  Notes can be changed for 
On Hold Invoices, but once an invoice is processed to completion, the notes cannot be changed.  



 

ExtremePOS 113

 
 
Invoice Discount 

 
 
This function allows you to apply a specific discount amount to the current invoice.  To apply a discount 
percentage to an invoice, press <CTRL+D>  or just insert the discount in the Invoice section at the bottom 
of the invoice screen.  Enter the discount amount as a percentage (ex: 15.00 for 15%). 
 
 
Line Discount 

 
 

 
 

This function allows you to apply a discount to a specific line of the current invoice. To apply a discount 
percentage to a particular line of an invoice, select Change Item Discount from the Invoice menu or press 
<CTRL+L>  in the Invoice Screen.  Enter the line number that you wish to discount, then click on OK  or 
press <ENTER>.  Enter the discount amount without the percent sign (ex: 15 for 15%), then click on OK  
or press <ENTER>.  Click on Cancel to quit without applying a discount. 
 
 



Chapter 5: Creating Invoices 
 

ExtremePOS 114 

Tax Menu 
 
 

 
 

The Tax menu allows you to apply or not to apply tax for taxable items on an invoice.  A check will appear 
next to the current selection.  To access this menu, click the Invoice menu bar. 
 
Tax This Order 
 
By default, ExtremePOS applies tax to each invoice.  To tax an invoice, select Tax This Order from the 
Tax menu or press <CTRL+O>  in the Invoice Screen. 
 
No Tax This Order 
 
This option allows you to bypass taxing taxable items.  To choose no tax for an invoice, select No Tax This 
Order  from the Invoice menu or press <CTRL+X>  in the Invoice Screen.  You may also bypass tax by 
setting up a customer with a tax-exempt status.  If this customer is selected for an order, tax will not be 
applied. 

 
NOTE:  You must choose this option BEFORE you add any items to the invoice or else taxable items will 
be taxed. 
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Searching Inventory 
 
 
 

Extreme Lookup Screen 
 
 
 

 
 
 
 

The Extreme Lookup screen is your primary interface for performing inventory lookups while in POS 
operations.  You can access this screen by selecting Lookup from the “Scan Item” group box on the invoice 
screen, selecting “Extreme Lookup” from the “POS Operations” tab in the Invoice screen toolbar, or hitting 
F10 while in the Invoice screen.  The following are the functions available on the Extreme Lookup screen. 
 
 
Results Grid – The grid will display the results of your search.  When the screen is first entered, the grid 
will be blank until “Show all Items”, “ Quick Search” or “Advanced Search” is selected.  Only fields 
containing critical information are displayed.  To view additional information about an item, you should 
look it up in the Inventory Maintenance screen.  The grid will display the results of your search in “pages”.  
Each page will contain 20 items.  The screen displays the current page number and the total number of 
pages in your search results.  It also displays the record numbers shown on the current page and the total 
number of records.  You can navigate through the search results using the “Previous” and “Next” buttons 
or by typing a page number to jump to that location.  You can customize the appearance of the data on the 
grid by: 
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1. Click on a column header and click on the resulting drop down arrow.  This will bring up a list of 
fields and allow you to select which field you want to display in that column.  Selecting a new field 
will cause your selection to switch locations with the currently displayed field. 

 
 

 
. 

 
2. Left click on a column header and hold the button to drag a field to the desired location on the 

grid.  The field will move to the location you’ve dragged it to and the other fields will shift over. 
 
3. Left click and hold on the dividing line to the right of a field and drag the line to increase/decrease 

the field size. 
 

 
 
 
 
Double Click on an item on the grid to add it to the current invoice.  This has the same effect as clicking the 
Select Button.  An input box will come up to allow you to enter the quantity.  (Note that the state of the used 
settings on the Invoice form will determine the used properties of the item when it gets added to the invoice.  
You can later change the item’s used properties from the Invoice form if necessary.) 
 
 
File Menu   
Exit  – Selecting this will close the Extreme Lookup screen 
 
Tools Menu 
Save Grid Settings – selecting this will save the current grid appearance (field order and field width).  
ExtremePOS will remember these settings whenever you re-enter the screen in the future.  
 
Previous Button – This will navigate to the previous page of data 
 
Next Button – This will navigate to the next page of data 
 
Page Number Box – Typing a page number within the current range of pages and hitting “Enter” will jump 
to that page. 
 
Show All Items Button – This will show all the items currently in your inventory database 
 
Quick Search – This will allow you to quickly find an item by item number.  An input box will be 
presented.  Type or scan an item number into the box to search for that item. 
 
Advanced Search Button – This will bring up the Advanced Search Screen which will allow you to filter 
and sort your search results.  The Advanced Search screen is discussed in the next topic. 
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Select Button – This will add an item to the current invoice.  An input box will come up to allow you to 
enter the quantity.  (Note that the state of the used settings on the Invoice form will determine the used 
properties of the item when it gets added to the invoice.  You can later change the item’s used properties 
from the Invoice form if necessary.)   
 
Exit Button  – This will close the Extreme Lookup screen. 
 
 
 
 
 

Advanced Search Screen 
 
 
 

 
 
 
 

The Advanced Search screen allows you to conduct detailed searches against your inventory.  The 
following functions are available on the Advanced Search screen. 
 
 
Inventory/Vendor option buttons – This allows you to specify whether you wish to search your inventory 
or a vendor database file.  You should always select Inventory.  Vendor searches are currently not 
implemented in the software. 
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Filter Boxes – You can select up to 3 filter criteria.  By default all filter criteria come up as “N/A” (not 
applicable).  To set your filter criteria: 

1. Choose a field to filter by from the leftmost filter box. 
2. Choose a filter option from the center filter box.  You can choose whether the selected field should 

equal, start with or contain your filter string. 
3. Type the string to filter by in the rightmost filter box. 

 
Sort Boxes – You can sort your results by up to 3 fields.  Select a field from the drop down list to sort by 
that field.  By default, the sort boxes display “N/A” until you select a field.  The results will be sorted by the 
field in the topmost sort box first, then the second and third boxes. 
 
NOTE: The Advanced Search screen remembers the filter and sort settings for your last search and will 
redisplay them when you re-enter the screen. 
  
OK Button  – Click this to start your search.  The Advanced Search screen will close and you will be 
returned to the Extreme Lookup screen.  Your search results will be displayed on the Extreme Lookup 
results grid. 
 
Cancel Button – Selecting this will close the Advanced Search screen without performing a search. 
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Steps for Invoicing an Order 
 

1. Select Customer (Chapter 5: Creating Invoices): 
 

• Use the default Cash Customer (#101) 
 

Or 
 

• Use Quick Search or Lookup to select a customer 
 
2. Tax (Chapter 5: Creating Invoices): 
 

• Use the default Tax This Order 
 

Or 
 

• Select No Tax This Order from the Tax menu 
 
NOTE:  You must select No Tax This Order BEFORE you add any items to the invoice or else 
taxable items will be taxed. 

 
3. Select Inventory Items to be placed on the Invoice Grid (Chapter 5: Creating Invoices): 

 
You can either scan in the item number with a bar code scanner or manually enter the item number or 
item name.  
 
- Non-Inventory Items (Chapter 3: Inventory Control): 

 
If you wish to add a non-inventory item to the invoice grid, select Non-Inventory Item from the 
Invoice or Actions menu or press <CTRL+N> .  The Non-Inventory Item screen will appear.  
Enter the required information, and then click on Add to Invoice or press <ALT+A>  to add the 
item to the current invoice.  To quit without adding an item, click on Cancel. 

 
NOTE:  All items entered using the Non-Inventory Item screen will be tracked under the item 
Non-Inventory Item. 

 
4. Deleting an Item from the Invoice Grid (Chapter 5: Creating Invoices): 
 
To delete an item from the invoice, press <CTRL+G>  to position the cursor on the invoice grid or click on 
the item on the grid with the mouse.  Use the up/down arrow keys (<↑↑↑↑> and <↓↓↓↓>) to move the cursor to the 
item to be deleted.  Once you highlight the item in the invoice grid you would like to delete, just press the 
<Delete> key on your keyboard. 
 
5. Changing the Item Quantity on the Invoice Grid (Chapter 5: Creating Invoices): 
 
To change quantity for an item on the invoice, press <CTRL+G>  to position the cursor on the invoice grid 
or click on the item on the grid with the mouse.  Use the up/down arrow keys (<↑↑↑↑> and <↓↓↓↓>) to move the 
cursor to the item to be changed.  Once you highlight the item in the invoice grid you would like to change, 
just click the attribute you would like to change within the Selected Item section of the invoice.  In this 
case, choose Change Quantity or <CTRL+Q > and follow the on-screen prompts. 
 
6. Changing the Item Price on the Invoice Grid (Chapter 5: Creating Invoices): 
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To change the price for an item on the invoice, press <CTRL+G>  to position the cursor on the invoice grid 
or click on the item on the grid with the mouse.  Use the up/down arrow keys (<↑↑↑↑> and <↓↓↓↓>) to move the 
cursor to the item to be changed.  Once you highlight the item in the invoice grid you would like to change, 
just click the attribute you would like to change within the Selected Item section of the invoice.  In this 
case, choose Change Price or <CTRL+I > and follow the on-screen prompts. 
 
7. Repeat steps 3-6 for all items purchased.   
 
8. Invoice Notes (Chapter 5: Creating Invoices): 
 

Add notes to an invoice by selecting Invoice Notes from the Invoice menu or by pressing 
<CTRL+T> . 

 
9. Invoice Discount (Chapter 5: Creating Invoices): 
 

Apply a specific discount amount to the entire invoice by selecting Invoice Discount from the Invoice 
menu or by pressing <CTRL+D> .  As an alternative, you may enter a discount in the Discount% input 
box within the Invoice section at the bottom of the invoice screen. 

 
10. Line Discount (Chapter 5: Creating Invoices): 
 

Apply a discount to a specific line number of the invoice by selecting Line Discount from the Invoice 
menu or by pressing <CTRL+L> . 

 
11. Put Invoice On Hold (Chapter 5: Creating Invoices): 
 

Place an invoice on hold by selecting Put Invoice On Hold from the Invoice menu or pressing 
<CTRL+H >.  You will be prompted to enter a Hold ID of up to 4 digits. 
 

12. Recall On Hold Invoice (Chapter 4: Creating Invoices): 
 

To recall an On Hold Invoice, select Recall On Hold Invoice from the Invoice menu or press the 
Recall On Hold button within the Invoice section at the bottom of the invoice screen.  You will be 
prompted to enter the Hold ID that you originally entered when you placed the invoice on hold. 

 
13. Select Payment Method (Chapter 5: Creating Invoices): 
 

There are six payment methods: 
• Credit Card:  You will be prompted to enter credit card information for the sale 
• Cash:  This is the default payment method. 
• Check:  You will be prompted to enter the check number. 
• Gift:   You will be prompted to enter the gift certificate or card number. 
• Split Tender: This uses a combination of two or more payment methods. 
• On Account: This form of payment can only be selected if the customer has an open account. 

 
14. End Transaction (Chapter 5: Creating Invoices): 
 

Once all of the items have been added and you have selected the payment method, click on End 
Transaction or press <ALT+E>  to complete the invoice. 

 
15. Amount Tendered: 
 

This is the amount of money that the customer gave to the cashier.  Enter the correct amount tendered, 
then click on OK  or press <ENTER> to complete the transaction.  Click on Cancel or press 
<ALT+E>  to exit without completing the transaction. 
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16. Receipt Prompt: 
 

 
If Print Invoices is set to Prompt in the Options Screen, this screen will appear.  Click on Yes or 
press ‘Y’ to print a receipt, or click on No or press ‘N’ if you do not want to print a receipt. 
 
Change: 

 

 
This is the amount that the customer should receive back based on the amount tendered and the grand 
total of the invoice.  Click on OK , press <ENTER>, or press <ALT+O>  to clear the screen for a new 
invoice. 
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Chapter 6 : 
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Invoices Menu 
 

 
 

The Invoices menu offers options regarding invoices.  To access this menu, click on View in the Invoice 
Screen menu bar or press <ALT+V> . 
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Recall Invoice 
 

 
 
This function allows you to display a completed or voided invoice.  To view an invoice, select Recall 
Invoice from the View/Invoices menu.  To reprint the invoice from this screen, click on Print Invoice or 
press <ALT+P> .  The date the invoice was processed appears below the inventory grid in the Invoice Date 
field.  Once you are done viewing an invoice, click on Done or press <ALT+D>  to exit this screen. 
 

 
 
NOTE: When you recall an invoice, you cannot edit it in any way, nor can you delete it. 
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Recall On Hold Invoice 
 

 
 
This function allows you to recall an on hold invoice by the Hold ID that you entered when you originally 
put it on hold.  Once you recall an on hold invoice, you can process it to completion, void it, modify it, or 
put in on hold again.  To access this screen, select Recall On Hold Invoice from the Invoice menu.  For 
more information on placing an invoice on hold, see the Put Invoice On Hold section in Chapter 4: 
Creating Invoices. 
 
 

Display On Hold ID Numbers 
 

 
This function displays an on screen report of all the invoices currently on hold.  The report also shows the 
corresponding On Hold ID, invoice number, as well as the date and time that the invoice was placed on 
hold.  You can use this report if you forget the On Hold ID for an invoice.  To access this screen, select 
Display On Hold ID Numbers from the Invoice menu. 
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Track Serial Numbers 
 

 
 

This function allows you to track a serial number for an item that was purchased.  To track a serial number, 
click on Track Serial Numbers from the Tools menu bar, hit Lookup Serial Number, enter the serial 
number, then click on OK  or press <ENTER>.  The serial number will appear, as well as the associated 
item number, item name, price, invoice number, date that the invoice was processed, and the customer who 
purchased the item.  If the serial number has been used more than once, you can use Next and Previous to 
track all the occurrences of that serial number until the correct one is displayed. 
 
 

Last Invoice Processed 
 

 
This function displays the invoice number of the last invoice processed on that computer.  To access this 
screen, select Last Invoice Processed from the View/Invoices menu or press <CTRL+F8>. 
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Print Last Invoice Processed 
 

This function prints a receipt for the last invoice processed on that computer.  To use this function, select 
Print Last Invoice Processed from the View/Invoices menu or press <SHIFT+CTRL+F8> . 

 
Reports Menu 

 

 
 

ExtremePOS offers you the ability to generate a wide variety of reports.  The following are brief 
descriptions of all the reports.  Many of the reports require parameters in order to run them, such as a date 
range, and most of the reports can be displayed on the screen and then printed from there. To access this 
menu, click on Reports in the Invoice Screen menu bar or press <ALT+R> in the Invoice Screen. 
 

Print Detailed Daily Report 
 
This is perhaps the most widely used and import report in ExtremePOS.  This report prints the sales totals 
for the day.  You can also get a breakdown by payment type, accounts receivable payment type, department, 
item, and you can choose to print for all cashiers or for a particular cashier as well as all workstations or a 
particular workstation.  You can also choose to Include Costs if you have an 80 column printer.  This will 
print the cost, extended cost, gross margin, and gross margin %.  To print this report, select Print Detailed 
Daily Report from the Reports/General menu, select the desired cashiers, stations, date, and breakdown, 
and then click on Print  or press <ALT+P> .  Click on Exit  or press <ALT+X>  to exit without printing the 
report. 
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Below is a sample of what is included in the Detailed Daily Report: 
 
 



 

ExtremePOS 129



Chapter 6: Sales Information and Reports 
 

ExtremePOS 130 

 

Generate Invoice Totals Report 
 
This report prints detailed information from invoice processing.  You can view an Invoice Totals Report 
for all cashiers or for a specific cashier.  You can also choose to view either complete, on hold, or voided 
invoices.  You can select any date range you wish.  To view a single day, use the same start and end date.  
The report displays the following information about an invoice: Date/Time, Invoice Number, Customer 
Number, Cashier ID, Payment Method, Total Cost, Total Price, Tax, Grand Total, and Gross Profit.  It also 
displays the total number of invoices processed and the grand totals.  To view this report, select Generate 
Invoice Totals Report from the Reports/General menu. 
 

Invoice Totals by Customer 
 
This report displays all invoices in a given date range.  It is sorted by customer last name.  To view a single 
day, use the same start and end date.  The report displays the following information about an invoice: 
Customer Last Name, Customer First Name, Invoice Number, Date/Time, Customer Number, Total Price, 
and Grand Total.  It also displays the total of all invoices in the specified date range for each customer and a 
grand total of all invoices.  To view this report, select Invoice Totals by Customer from the 
Reports/General menu. 
 

Grand Totals by Payment Method 
 
This report breaks down the invoices by their payment methods.  To view this report, select Grand Totals 
by Payment Method from the Reports/General menu. 
 
 

Print Daily Totals on Receipt Printer 
 
This report is a summary of all the invoices for all cashiers for the specified date.  This report will print on a 
standard receipt printer.  To print this report, select Print Daily Totals on Receipt Printer from the 
Reports/General menu. 
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Hours and Wages 
 

 
This report displays the total wages earned and tips collected in a specified date range.  You can choose to 
generate this report for a specific cashier or employee department.  To display this report, select Hours and 
Wages from the Reports menu, enter the desired information, then click on Generate or press <ALT+G> .  
Click on Exit  or press <ALT+X>  to exit without generating this report. 
 
 

Sales Analysis 
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This screen allows you to produce a variety of reports for a specified date range. 
 
Sales Summary Reports allow you to choose a criterion you wish to view sales by, such as hourly or by 
vendor, for one or all cashiers.  Check the radio button next to the one you wish to view, select Show 
Graphs if you want to make graphs, and hit Show Report at the bottom left.  You will be prompted for 
whether to show for one cashier or all, as well as the date range. 
 
Sales Detail Reports give you a detailed departmental breakdown.  Select the department and whether to 
Show by Item Name, Show by Item Description, or Show by Category Name.  Hit Show Report to 
bring your report up.  You will be prompted for whether to show for one cashier or all, as well as the date 
range. 
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Grand Total by Date 
 

 
This function displays a message box with the selected day’s grand total.  To access this screen, select 
Grand Total by Date from the Reports/Grand Totals menu, enter the desired date, and then click on OK  
or press <ENTER>. 
 

Grand Total by Cashier 
 

 
This function displays a message box with the selected cashier’s grand total for the selected day.  To access 
this screen, select Grand Total by Cashier from the Reports/Grand Totals menu, enter the desired 
cashier number and date, and then click on OK  or press <ENTER>. 
 

Grand Total by Salesperson 
 

This report prints the grand total for each salesperson for a specified date range.  You can choose to 
generate this report for either a specific salesperson or for all salespeople.  To print this report, select 
Grand Total by Salesperson from the Reports/Grand Total menu, enter the desired information, then 
click on Generate or press <ALT+G> .  Click on Exit  or press <ALT+X>  to exit without printing this 
report. 
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Grand Total Sales by Department 
 

 
This function displays a message box with the grand total for the specified department as well as the amount 
of items from that department that were sold.  To access this screen, select Grand Total Sales by Dept 
from the Reports/Grand Totals menu, then enter the desired department, starting date, and ending date. 
 

Grand Total Sales by Item 
 

 
This function displays a message box with the grand total for the specified item as well as how much of that 
item were sold.  To access this screen, select Grand Total Sales by Item from the Reports/Grand Totals 
menu, and then enter the item number, starting date, and ending date. 
 

Grand Total of Tax Exempt Sales 
 

 
This function displays a message box with the total of taxed sales, the total of tax exempt sales, and the total 
sales all before taxes were applied.  To access this screen, select Grand Total of Tax Exempt Sales from 
the Reports/Grand Totals menu, enter the desired date, and then click on OK  or press <ENTER>. 
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Inventory Reports 

 
 

List 
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This report allows you to list your new or used inventory grouped and sorted as you choose. 
 
New or Used in the first dropdown box allows you to choose between new or used quantities. 
 
Group Inventory By  allows you to choose whether to group your items by category or department. 
 
Sort Inventory By determines the ordering within groups. Available options are Item Name, Item Number, 
and Item Description 1. 
 
Show Inactive Items:  Checking this will show items you have marked as Inactive on the report in addition 
to your active inventory. 
 
Show Only Positive Quantities:  Checking this will show only items whose in stock quantity is greater 
than zero. 
 
Show Only Non-Zero Quantities:  Checking this will show only items whose in stock quantity is not equal 
to zero.   
 
Show Only Items Where Cost is not Zero:  Checking this will show only items whose cost is not equal to 
zero. 
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Daily Itemized Sales 
 

 
This function displays a message box with the total number sold of a particular item on a particular date.  
To access this screen, select Inventory Reports from the Reports menu, then select Daily Itemized Sales.  
Enter the item number and the desired date, then click on OK  or press <ENTER>. 
 
Daily Sales by Dept 
 

 
This function displays a message box with the total number of items sold from a particular department on 
the selected day.  To access this screen, select Inventory Reports from the Reports menu, then select  
Daily Sales by Dept.  Enter the department number and the desired date, then click on OK  or press 
<ENTER>. 
 
Sales Summary 
 
This report lists a monthly breakdown of quantity sold, total cost, total sales, and gross profit for every 
inventory item.  The items are listed by item name.  To view this report, select Inventory Reports from the 
Reports menu, then select  Sales Summary. 
 
Serial Number Sales 
 
This report lists all the serial numbers sold for a specified range of dates.  The following information is 
displayed in the report: Invoice Number, Date, Serial Number, Item Name, Item Number, and Customer 
Name.  To view this report, select Inventory Reports from the Reports menu.  Select Inventory Reports 
– Serial Number Sales, then enter the desired dates. 
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 Departments 
 
This report generates a complete listing of all the Department IDs with their corresponding descriptions.  To 
view this report, select Inventory Reports from the Reports menu, then select  Departments. 
 
 
 Items By Department 
 

 
 
This report displays information about inventory in a specific department.  The following information is 
displayed in the report: Item Name, Item Number, Department, Cost, In Stock, Value, and Price.  To view 
this report, select Inventory Reports from the Reports menu, then select Items By Department.  Use the 
mouse or the arrow keys to highlight the desired department, and select either new or used.  Click on 
Report or press <ALT+R>  to display the report.  Click on Done to exit without viewing the report.   
 
Items by Vendor 
 
This report lists items for a specified vendor in numerical order by item number.  The following information 
is displayed in the report: Item Number, Item Name, Department, Cost, In Stock, Value, and Price.  To view 
this report, select Inventory Reports from the Reports menu.  Select  Items by Vendor, enter the desired 
vendor number, then click on OK  or press <ENTER>. 
 
Vendors 
 
This report generates a complete listing of all the vendors and their corresponding vendor number.  The 
following information is displayed in the report: Vendor Number, Contact Name, Company Name, City, 
State, Zip Code, and Phone Number.  To view this report, select Inventory Reports from the Reports 
menu, then select Vendors. 
 
Display Current Value 
 

 
 
This function displays a message box with the current value of your inventory.  To access this screen, select 
Inventory Reports from the Reports menu, then select Display Current Value. 
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Current Items 
 
This function displays a message box with the current number of valid items.  To access this screen, select 
Inventory Reports from the Reports menu.  Select Current Items, then enter the start and end date of the 
desired date range. 
 
Incoming Items 
 
This report shows items that are coming in open purchase orders.  To view it, select Inventory Reports 
from the Reports menu, then Incoming Items. 
 
25 Top Selling Items 
 
This report lists the 25 top selling inventory items during the specified date range.  To view this report, 
select Inventory Reports from the Reports menu.  Select 25 Top Selling Items, enter the start and end 
date of the desired date range, then click on OK  or press <ENTER>. 
 
 
 

Rental Reports 
 

 
 
Late Rentals Report 
 
This report lists rentals that are currently overdue.  To print this report, select Rental Reports from the 
Reports menu, then select Late Rentals Report. 
 
 Currently Rented 
 
This report lists items that are currently rented.  The following information is displayed in the report: Item 
Number, Item Name, and the Customer Number, Customer Name, and phone number of the cusomter 
currently renting the item.  To view this report, select Rental Reports from the Reports menu, then select 
Rentals Currently Rented. 
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Rentals in Store 
 
This report lists rental items that are currently in the store.  The following information is displayed in the 
report: Item Number, Item Name, and the Customer Number, Customer Name, and phone number of the 
last customer to rent the item.  To view this report, select Rental Reports from the Reports menu, then 
select Rentals in Store. 
 
Rental History 
 
This function displays the rental history of a rental item.  The top grid contains the following information: 
Date the item was rented, Invoice Number, Customer Number that rented the item, and Price.  The bottom 
grid contains the following information: Item Number, Total Number of times that the item has been rented, 
and the total amount of money from the rental (not including tax).  To view this screen, select Rental 
Reports from the Reports menu, then select Rental History.  Click on Select or press <ALT+S>, then 
enter the item number.  Click on Exit  or press <ALT+X>  to exit the Rental History screen. 
 
Rental Transactions 
 
 This function allows you to view rental transactions in a date range.  To view this screen, select Rental 
Reports from the Reports menu, then select Rental Transactions.  Click on Select or press <Alt+S>, then 
choose how to sort it. 
 

Number of People Served 
 
This function displays a message box showing how many people were served within a specified time range 
when recorded through touch screen invoicing in Restaurant ExtremePOS.  You will be prompted to enter 
the start date and the end date of the desired range.  To access this screen, select Number of People Served 
from the Reports/Industry Specific menu. 
 
 

Server Tips 
 
This report lists all of the server tips for credit card purchases during a specified time range.  The report 
lists the Server ID, Date, Time, Invoice #, and Tip Amount and is sorted by Server ID.  To view this report, 
select Server Tips from the Reports/Industry Specific menu. 
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Accounts Receivable Reports 

 
 

Accts Receive – Customer Summary 
 
This report displays a summary of all customers and their current balances.  The following information is 
displayed in the report: Customer Number, Last Name, First Name, Company Name, and On Account 
Balance Due.  To view this report, select Accounts Receivable Reports from the Reports menu, then 
select Accts Receive – Customer Summary.  You can choose to sort by Customer Number or by Last 
Name. 
 
Accts Receive – Customer Statement 
 
This function prints a billing statement for either all customers or a specific customer.  To print a statement 
for all customers, select Accounts Receivable Reports from the Reports menu.  Select Accts Receive – 
Customer Statement, then select All Customers.  You will be asked whether or not to print statements for 
customers that have a total balance due of $0.00 and to enter the starting date of transactions.  To print a 
statement for a specific customer, select Accounts Receivable Reports from the Reports menu, then select 
Accts Receive – Customer Statement.  Select Specific Customer, then enter the customer number.  You 
will be asked whether or not to print statements for customers that have a total balance due of $0.00 and to 
enter the starting date of transactions.  NOTE: Invoices that have been fully paid appear on the 
statement for 30 days. 
 
 

Customer Reports 
 

 
Customer Membership Info 
 
This report generates a list of all the customers who have an active club membership.  The report lists the 
Customer Number, Full Name, and Membership Expiration Date.  To view this report, select Customer 
Reports from the Reports menu, then select Customer Membership Info. 
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Customer Purchases 
 
This report displays a list of customers who purchased a specific item.  The following information is 
displayed in the report: Date, Time, Customer Number, First Name, and Last Name.  To view this report, 
select Customer Reports from the Reports menu, then select Customer Purchases. 
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Customer Sales History 

 
 
This report displays the sales history of either all customers or a specific customer for a specified range of 
dates.  The report shows every invoice and every item sold to the customer along with how many bonus 
points were earned.  Each customer record appears on a separate page.  To view this report, select 
Customer Reports from the Reports menu, then select Customer Sales History.  Enter the start and end 
date, select either all customers or enter a specific customer number, then click on Display or press 
<ALT+D> .  Click on Exit  or press <ALT+X>  to exit without viewing the report. 
 
Most Frequent Buyers (Top 10) 
 
This function displays a message box with the top ten frequent buyers for a specified date range.  To access 
this screen, select Customer Reports from the Reports menu, select Most Frequent Buyers (Top 10), 
then enter the start and end date of the desired date range. 
 
Phone List 
 
This report generates a list of customers and their phone numbers.  You can sort the list by either customer 
number or customer last name.  The following information is displayed in the report: Customer Number, 
Last Name, First Name, Company Name, Phone Number, and Alternate Phone Number.  To print a 
Customer Phone List by Customer Number, select Phone List from Customer Reports in the Reports 
menu, type ‘1’, then click on OK  or press <ENTER>.  To print a Customer Phone List by Customer Last 
Name, select Phone List from Customer Reports in the Reports menu, type ‘2’, then click on OK  or 
press <ENTER>. 
 
Ship To Info 
 
This report generates a list of customers and their Ship To addresses.  All customer information, including 
credit card information, is printed.  To print this report, select Ship To Info from Customer Reports in the 
Reports menu. 
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Gift Cards 
 

 
 

This report will allow you to check the current outstanding balances on gift cards and receipts, or allow you 
to view a specific card’s transaction history.  To see a report of all balances, check the radio button next to 
View Current Gift Card Balances and hit OK.   To see a card’s history, hit the radio button next to 
Transaction History for Gift Card #  and fill in the card you wish to view.
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Sample Report 
 

 
The above is a sample ExtremePOS report.  At the top of each report view screen there are several 
command buttons with specific functions: 
 

Use these buttons to go to the first and last pages of the displayed report. 
 

 
Use these buttons to the previous or next page of the displayed report. 
 

 
Click on this button to print the current report.  You may print the whole report or a selection of 
pages. 

 
Click on this button to export your report to another program.  The following are your choices of 
format: Lotus 1-2-3 spreadsheet, Excel spreadsheet, Word for Windows, Crystal Reports, Data 

Interchange Format, HTML, Record Style, character-separated values, comma-separated values, paginated 
text, rich text format, text, tab-separated values, and tab-separated text.  You must save the export file as a 
disk file (default) or Microsoft Mail (MAPI). 
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ExtremePOS Tools  
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Tools Menu 

 
 

The Tools menu contains several tools to use with ExtremePOS.  To access this menu, click on Tools in the 
Invoice Screen. 
 

Touch Screen 

 
The Touch Screen in ExtremePOS can be used in conjunction with a touch screen monitor to process 
invoices.  You can do the same functions for invoicing as in the Invoice Screen, such as select a customer, 
enter a non-inventory item, recall an On Hold invoice, enter a multiple quantity, delete an item, discount an 
item, and void an invoice.  You can choose to use a scanner or you can manually enter item numbers using a 
keyboard.  You can also choose to display departments to minimize the number of items on the screen at 
once.  To use the Touch Screen, select Touch Screen from the Tools menu.  For more information on this 
screen, see Chapter 9: Restaurant ExtremePOS: Invoice Screen. 
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Data Import 
 

Import Inventory 
 

 
 
Import Inventory allows you to import delimited or fixed length vendor text files.  Please contact technical 
support for help with this advanced feature of ExtremePOS. 
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Scheduler 
 

 
Scheduler allows you to schedule events under different Cashier IDs. 

 
Select Specific Date  
 
Select this option to move to a specific date on the calendar (Example: 7/2/99 for July 2, 1999) 
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Schedule Event 
 
To schedule an event: 
 

• Select a day by either clicking on a day on the calendar or selecting a date using Select Specific 
Date. 

 
• Select the start time of the event by clicking on the appropriate box under the desired Cashier ID. 

 
• Click on Schedule Event or press <ALT+S>.  This screen will appear. 

 
 

• Select a customer by clicking on S or by pressing <ALT+S>.  Then enter the correct end time of 
the event and description. 

 
• Click on OK  or press <ALT+O>  to schedule the event or click on Cancel or press <ALT+C>  to 

exit the screen without scheduling an event. 
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Unschedule Event 
 
To unschedule an event: 
 

• Click on the event that you wish to cancel or use the arrows to highlight the desired event. 
 

• Click on Unschedule Event or press <ALT+U>  to unschedule the event. 
 
 
Mass Unschedule 
 
Mass Unschedule unschedules all past scheduled events.  To do this, click on Mass Unschedule or press 
<ALT+ M> . 
 
 

Clock In/Clock Out 
 

 
This function allows employees to clock in or clock out.  Restaurant employees are prompted to enter the 
amount of tips they collected when they clock out.  To access this screen, select Clock In/Clock Out  from 
the Tools Menu.  To clock in, click on Clock In  or press <ALT+I> .  To clock out, click on Clock Out or 
press <ALT+O> .  Click on Cancel or press <ALT+C>  to quit without clocking in or out. 
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Labor Scheduling 
 

Labor Scheduling allows you to create work schedules for your employees in EXTREMEPOS. 
 
Schedule 
 
To schedule an employee: 
 

• Select a day by clicking on a day on the calendar. 
 
• Click on Schedule or press <ALT+S>. 

 
• Enter the desired information then click on Done or press <ALT+D> . 

 

 
Unschedule 
 
To unschedule an employee: 
 

• Click on the event that you wish to cancel. 
 

• Click on Unschedule or press <ALT+U>  to unschedule the employee. 
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View Schedule 
 
To view a day’s schedule: 
 

• Select a day by clicking on a day on the calendar. 
 
• Choose which schedules to display, either Employees in Department or Specific Employee. 

 
• Select ALL  to display all employees in all departments, or select a specific department or 

employee to display. 
 

• The Employee ID, Start Time, End Time, and Hour/Min for the selected employees will appear in 
the grid. 

 
 

Wage Calculator 
 

 
Wage Calculator allows you to calculate an employee’s wages for a specified range of dates based on the 
hourly wage entered in Employee Maintenance.  To calculate an employee’s wages, select Wage 
Calculator from the Tools Menu, select the employee, enter the tax rate and range of dates, then click on 
Calculate or press <ALT+C> .  Click on Exit  or press <ALT+X>  to exit without calculating wages. 
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Using Gift Cards  with 
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Selling Gift Cards:  

In order to sell a gift card at the register, just enter GC in the item number box at the POS screen.  

 

This will bring up the Gift Card / Gift Receipt sale screen, shown below. At this screen, select whether you 
want to sell a physical gift card or print a gift receipt. Then scan or type in the gift card number. If you are 
printing a gift receipt, you can choose to let the system autogenerate a number for you by hitting the 
Autogenerate button under the card number text box. Then enter the gift card / gift receipt amount in the 
amount box and hit OK to add the gift card / receipt to the current invoice.  
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Redeeming Gift Cards: 

To redeem gift cards / gift receipts, just hit "Gift" as the method of tender in the payment window. 

. 

 

This brings up the Gift Card / Receipt redemption screen, shown below. Scan or type the gift card number 
and the amount to redeem, then hit "Redeem". If there is a balance due to the customer and you want to 
issue a gift card / receipt for store credit, select "New". This will take you back to the Gift Card / Receipt 
sales screen where you can create the gift card / receipt.  
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You can re-enter the redemption screen to redeem additional gift cards by selecting "Gift" again from the 
payment window. When you are done, select OK from the payment screen as youn normally do. Any Gift 
Receipts you've sold will be printed after the sales receipt. 

It's that simple. Now you're ready to start using Gift Cards & Gift receipts!  
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Log-In Screen 
 

 
The first screen that appears when you run Restaurant ExtremePOS is the Log-in Screen.  To log in to 
Restaurant ExtremePOS, enter your Server ID and Table #, then click on Enter or press <ALT+E> .  Click 
on Delete or press <ALT+D>  to backspace or click on Clear or press <ALT+C>  to clear the entire field. 
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File Menu 
 

 
Several of the functions listed in the Restaurant ExtremePOS File menu have the same functionality in 
ExtremePOS. 
 
For more information on the following functions, see Chapter 1: Setting Up ExtremePOS: File Menu: 
 

• Select Industry 
• Select Database Location 
• Compact & Repair Database 
• Check Database 
• Clear Database 
• Employee Maintenance 
• Employee Permissions 
• Change Passwords 
• Add Station 
• Enable Multiuser Edition 

 
For more information on Options Screen, see Chapter 1: Setting Up ExtremePOS: Setup Menu: 
Options Screen. 
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Set Station ID 
 

 
This function allows you to set station IDs for different stations once they have been created using Add 
Station.  To access this function, select Set Station ID from the File  menu.  For more information on 
adding station IDs, see Chapter 1: Setting Up ExtremePOS: File Menu: Add Station. 
 
 

Order Filling 
 

This screen displays all orders sent to this Station ID as designated in the Printers tab of Inventory 
Maintenance.  Each tile shows a different invoice and they are displayed in the order in which they were 
placed.  When an order has been completed, click on No Order or the corresponding number or press 
<ALT+#>  to remove it from the active orders. 
 

View Main Invoice for More Options 
 
This function allows you to view the Main Invoice screen for more setup options.  These options include: 
adding inventory (See Chapter 2: Inventory Control ), adding customers (See Chapter 3: Customer 
Control ), and printing reports (See Chapter 5: Sales Information and Reports).  To display the main 
invoice screen, select View Main Invoice for More Options from the File menu. 
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Invoice Screen 
 

 
The Invoice Screen is where all of your daily invoicing will be done.  Administration tasks such as Reports, 
Accounts Receivable, Purchase Orders, and Inventory Control are performed in different screens.  
Select View Main Invoice for More Options from the File menu in the Log-In  screen to access these 
functions.  Further explanations on these functions can be found in earlier chapters. 
 
Before you begin processing invoices, you must manually enter your inventory items into REPOS. You may 
want to enter just a few items at first so you can get a feel of how the program works, then progressively add 
more items.  Refer to Chapter 2: Inventory Control  for more information on adding inventory items. 
 
NOTE:  For Restaurant ExtremePOS, all items MUST be entered into a department to appear on the 
Invoice Screen. 
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Dissecting the Invoice Screen 
 
Totals 
 

 
Running totals are kept for the current invoice.  Each time you add a new inventory item to the invoice, the 
totals portion is updated.  If you are using a pole display, that will be updated as well.  The top number is 
the Grand Total.  This line displays the invoice total after taxes.  The second line is the Tax Amount.  
This line displays the total amount of tax for the entire invoice. 
 
 
Invoice Grid 
 

 
The Invoice Grid shows all of the items in the current invoice.  The first column shows the item description.  
The second column indicates the quantity of that item, and the third column indicates the total price for that 
line.  Use the arrows on the side of the grid to scroll up and down.  The selected line of the invoice is 
highlighted yellow.  To select a line, use the Prev and Next buttons below the grid to move the marker to 
the desired line or click on the desired line with the mouse. 
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Departments 
 

 
All of the departments are listed in alphabetical order on the left side of the screen.  Up to seven 
departments can be displayed on the screen at one time.  Use the corresponding Prev and Next buttons to 
scroll up and down through the list of departments.  To select a department, press the desired button.  Once 
the department is selected, the button will be a lighter color and all the items in that department will appear 
on the screen. 
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Items 
 

 
Once a department has been selected, all of the items in it will be displayed.  Up to twenty-one items can be 
displayed on the screen at one time.  Use the corresponding Prev and Next buttons to scroll left and right 
through the list of items. 
 

 
To select an item, press the desired button.  Once an item has been selected, it will appear on the Invoice 
Grid.  NOTE:  To enter a multiple quantity for an item, you must press the # button and enter the 
appropriate quantity BEFORE selecting the item.  For more information on the # button, see the following 
section. 
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Additional Invoice Screen Buttons 
 

Delete: Click on this button to delete a line from the current invoice.  To delete a line, use Prev 
and Next to highlight the desired line, then click on the Delete button.  You will be prompted to 
enter the administrator password before being able to delete a line. 
 

 
Line Discount: Click on this button to discount a line in the current invoice.  To discount a line, 
use Prev and Next to highlight the desired line, then click on the Line Discount button.  Enter 
the percentage (not the decimal value) to be discounted, then press OK  to apply the discount.  If 
you make a mistake, you may press Clear to re-eneter a percentage or press Cancel to exit the 

screen without applying a discount. 
 

Quantity: Click on this button to enter a multiple quantity for an item. Enter the desired quantity, 
and then press OK .  If you make a mistake, you may press Clear to re-enter an amount or press 
Cancel to exit without choosing a quantity.  Once the quantity has been entered, select the 
desired item.  NOTE:   You must enter the appropriate quantity BEFORE   selecting the 

item. 
 

Extra Item:  Click on this button to add a non-inventory item to the invoice.  Enter the dollar 
amount of the non-inventory item, and then press OK  to add the item to the invoice.  If you make 
a mistake, you may press Clear to re-enter an amount or press Cancel to exit the screen without 
adding an item.  The item will appear as Extra Item  in the Invoice Grid. 

 
Customer: Click on this button to select a customer for the current invoice.  This will bring up 
the customer selection screen: 
 

 
 
To search for a customer, partially enter a customer number and then press the down arrow key <↓↓↓↓> to get a 
listing of all customers beginning with those numbers or letters.  You can also use the left and right arrows 
to scroll through your customers.  Click on Select to select the customer for the current invoice.  You can 
also click on Add or Edit  to open the Customer Maintenance screen (See Chapter 3: Customer 
Control) . 
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Invoice Discount: Click on this button to discount an entire invoice.  Enter the discount 
percentage (not decimal) for the invoice.  Press OK  to apply the invoice discount or press Cancel 
to exit without applying a discount.  Press Clear to re-enter a percentage. 
 

 
Check: Click on this button to print a check for the current invoice. 
 
 
 

 
Time: Click on this button to clock in or clock out.  For more information on this function, see 
Chapter 6: EXTREMEPOS Tools: Clock In/Clock Out. 
 
 

 
 
 

Option 
 
 
 

 
Click on this button to view more additional options – Last Receipt, Open Drawer, and Party Size. 
 

 
Last Receipt: Click on this button to print a copy of the last receipt printed at this station. 
 
Open Drawer: Click on this button to open the cash drawer.  You will be prompted to enter the 
administrator’s password. 
 
Party Size: Choose this option to enter the number of people in the party for the current invoice. Enter the 
correct number of people, and then press OK .  If you make a mistake, you may press Clear to re-enter an 
amount or press Cancel to exit the screen without entering a party size. 
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Done 
 
 
 

Click on this button to display options for exiting the invoice screen – Hold, Void Invoice, Last Receipt, 
and Exit . 
 

 
Hold:  Click on this button to place the current invoice on hold.  You will be returned to the Restaurant 
ExtremePOS Log-In screen. 
 
Void Invoice: Click on this button to void the current invoice.  You will be prompted to enter the 
administrator password. 
 
Last Receipt: Click on this button to print a copy of the last receipt printed. 
 
Exit:  Choose this option to exit the RPE Invoice Screen and return to the RPE Log-In Screen. 
 
 

Payment Options 
 
 
 

Click on this button to display payment options for the current invoice –CC Info, On Account, No Tax 
This Order . 
 

 
CC Info:  Click on this button to choose Credit Card as the form of payment for the current invoice.  You 
will be prompted to enter the credit card information. 
 
No Tax This Order:  Click on this button if tax should not be applied to the current invoice. 
 
On Account: Click on this button to choose On Account as the form of payment for the current invoice.  
You must select a customer before choosing this option. 
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End Transaction 
 
 

 
Click on this button to end a transaction.  If Prompt Amount Tendered is set to Yes in the Options 
Screen, the amount-tendered screen will appear: 
 

 
Enter the amount tendered in the correct field(s) (Cash, Check, Credit Card, On Account, or Gift 
Certificate).  You can enter the amount using either the keyboard or the on-screen number pad.  Once you 
have made your selection, click on OK  or press <ALT+O> .  You can click on Cancel or press <ALT+E>  
to exit without ending the transaction. 
 
Amount Due: This is the amount due from the customer for the current invoice. 
 
Amount Tendered: This is the payment received from the customer. 
 
Amount Remaining: This is the amount still due on the invoice.  Parentheses indicate a negative amount 
remaining (i.e. change to the customer). 
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Invoice Information 
 

 
This box shows information about the current invoice – Table #, Server ID, and Party. 
 
Table #: This is the table number where the party is seated. 
 
Server ID: This is the Server ID of the employee serving this party. 
 
Party:  This is the party name.  If a customer is selected, the customer’s last name will appear here, 
otherwise N/A. 

 
 

Restaurant Invoicing Tips 
 
Server IDs 
 

• When assigning Server IDs, make sure that they are easy to remember, such as the servers 
initials. 

 
Item Numbers 

• When assigning item numbers to items, have all similar items start with the same number.  For 
example, have all burgers start with 1000 (Hamburger – 1000, Cheeseburger – 1001, BLT – 
1002, etc.).  This will make reports much more organized and easier to read. 

 
Departments 

• When assigning a department ID to a department, select a number that is similar to the items 
in that department.  For example, if you were to create a department called “Burgers”, you 
would assign it Department ID 1000 since all of the burgers have item numbers that begin 
with 1000. 
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ExtremePOS is capable of taking Physical Inventory in one of two ways.  You will need to select one 
method or another.  You should NOT use both methods to attempt to speed up the inventory process. 
 
1. ExtremePOS works in conjunction with the ESC Mobile Inventory application, allowing you take and 

import inventory from a PDA device .  The recommended PDA devices supported by Mobile Inventory 
are the Symbol 1550 (with integrated barcode scanning) and the Handspring with CSM150 barcode 
scanner attachment. 

 
2. Physical Inventory can be performed on the station computer from within ExtremePOS. 
 
We’ll discuss the process for taking physical inventory using each of these mechanisms in the sections that 
follow. 

 
 

Physical Inventory Using ESC Mobile 
Inventory  

 
 
 

System Requirements 
Desktop: 

1. eXtremePOS, Musicware for Windows or Praiz for Windows 
2. Palm Desktop software (available free for download from http://www.palm.com ) 

PDA: 
1. ESC Mobile Inventory application 
2. Handspring Visor and Symbol CSM 150 Barcode Scanner springboard module or Symbol 

SPT 1550 with serial cradle 
 
 

The Physical Inventory Process 
This section will only describe the steps involved in taking physical inventory.  For more details on 
Mobile Inventory, see the next topic. 
 
 
Important:  First, select a POS station which you will use for physical inventory.  All physical 
inventory functions, including all HotSyncs, should be performed to the selected station.  
eXtremePOS currently does NOT support HotSyncing to multiple stations.  Performing 
HotSyncs to multiple stations will result in incorrect totals. 
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Step 1: Create and upload PDA Inventory Database 
 
Start eXtremePOS and select Tools -> Physical Inventory -> Mobile Inventory from the login screen to 
enter the Physical Inventory screen.   
 

 
 
In the “Generate PDA Database” frame, select the department(s) you want to inventory.  To inventory 
your entire store, select “All” from the Department list box.  To select multiple departments, hold down 
the “Control” key and click each department you want to select. 

Note: If you have a large number of items in inventory, it is recommended that you break down 
your physical inventory by department.  This will reduce the size of your PDA database and speed 
up database searches on the PDA.  Mobile Inventory will only recognize and count items in the 
selected departments. 

 
Select whether you want to include In-Stock Items only in your PDA database by checking or 
unchecking the box found below the department list.  If you have a large number of items in your store 
database that are not in stock, you may want to exclude these item in order to reduce PDA database 
size.   

Note: Be aware that if you exclude these items, they will not be recognized or counted by Mobile 
Inventory. 

 
Click “Generate Database” button.  The database files will be created and the resulting file size will be 
displayed.  Ensure the resulting file size does not exceed the available memory on your PDA device or 
the file HotSync will fail.  If you need to reduce the file size, reduce the number of departments to 
inventory or select “include in-stock items only” and click “Generate Database” again to recreate the 
database files.  There are 4 database files created.  They are: 
Cats.pdb 
Depts.pdb 
InvDtl.pdb 
InvMain.pdb 
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Click “Send to Palm Installer”.  This will start up the Palm Installer program (included with your Palm 
Desktop) and pass it the newly generated PDA database files.  Palm installer will come up and show 
you the files to be installed.  Select “Done”.  Palm Installer should give you a message box telling you 
that files will be installed the next time you perform a Hot Sync. 
Note: You will not be able to send files to Palm Installer again until you have performed a Hot Sync.  If 
you want to replace the database files with new ones, you should manually start up Palm Installer from 
Palm Desktop, select the 4 pdb files listed above and choose “remove” to clear them from the list of 
files to be installed.  You will then be able to send the new files from eXtremePOS. 
 
Insert your PDA in the cradle and perform a HotSync.  This will physically upload the database files to 
your PDA.  For more information on HotSyncing, see your PDA documentation.  The PDA will have to 
be HotSynced at the computer where the database was generated in order for the database to be 
uploaded. 
 
 
Step 2: Collect inventory using ESC Mobile Inventory 
 
This section is intended as an overview only.  Please review the “Mobile Inventory Tutorial” appendix 
to this manual before using Mobile Inventory.  

  
 
 
Mobile Inventory will need to be installed on your PDA.  Installation instructions are included in the 
“Readme” file provided with your Mobile Inventory application. 
 
Launch Mobile Inventory by clicking the Barcode icon on your PDA.  Select “Start” from the startup 
screen.  This will bring you to the Scan Screen.   
 
Begin taking inventory.  Scan items to add them to your quantities by selecting the Scan button on the 
screen.  At any time, you can see the current count and expected count for an item by selecting “details” 
while that item is displayed on the screen.   

Note:  Symbol will allow you to choose any of the 4 keys on your PDA to double as a scanner key.  
This may simplify the process of taking inventory since it may be inconvenient to hit the onscreen 
button at certain angles.  To select a scan key, click on the “Symbol” icon on your PDA screen and 
follow the instructions. 
Note: Mobile Inventory will only recognize and count items in the departments you selected when 
generating the database, so you should only inventory these departments.  You will be able to 
repeat this process as many times as needed in order to inventory all desired departments.  Select 
“Options” from the startup screen to view all the departments included in your database 

 
When you have completed taking inventory, exit Mobile Inventory by selecting “Done” on the scan 
screen, then “Exit” on the startup screen. 
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Step 3: Import Inventory from your PDA 
 
Restart eXtremePOS, and enter the Physical Inventory screen again.   
 
Click the “Start” button in the “Import Mobile Inventory Data” frame.  eXtremePOS will now walk you 
through the process of importing your data.  First, eXtremePOS will create a new Physical Inventory 
database on your computer if one does not exist.  This database will be used to sum up totals from all 
your Mobile Inventory sessions.  Then eXtremePOS will enable the Conduit program that will be used 
to sync your PDA database with the Physical Inventory database on your desktop during HotSync. 
 
eXtremePOS will ask you to perform a HotSync, then hit “Done” when complete.  Put your PDA in the 
cradle and perform a HotSync.  Wait until the HotSync has completely finished before hitting “Done” 
on the Physical Inventory screen.  Hitting “Done” button early will result in improper program 
operation. 
 
Note:  Ensure you always HotSync to the same station you have selected for physical inventory. 

 
eXtremePOS will now complete the import and add the PDA database totals to the Physical Inventory 
database on your computer.  Because eXtremePOS  keeps a running total of your inventory, you may 
import  multiple times with one or more PDAs running Mobile Inventory. 
 
To continue to count inventory in the same department(s), restart Mobile Inventory and clear the 
quantities to start with zero count in the database.  For information on clearing quantities, see the 
Mobile Inventory tutorial. 
To take inventory in different department(s), create a new PDA database as described in step 1, 
selecting the desired departments from the department list box. 
 
 
 
Step 4: View Discrepancy Report 
 
Select View or Print inventory discrepancy report to see all differences between expected and actual 
quantities, and value of any lost inventory.  Discrepancy report addresses both new and used items.  If 
you select to view the report, it will be sent to a text file in your store data directory named 
“DiscRpt.txt”.  You can select to save this to a unique file name if you wish to retain the report.  
Otherwise the report will be overwritten the next time “View Report” is selected. 
 
Note:  When quantities are updated, the final discrepancy report will be automatically saved to your 
store data directory under Backup\Reports.  The filename will be based on the date and time the report 
was created.  The program will inform you of the location and filename that the final report is saved to.. 
 
 
Step 5: Update Quantities 
 
Selecting “Update Inventory” will update overwrite the quantities in your store database with the 
counted quantities in your physical inventory database.  Update should not be performed until you have 
COMPLETELY inventoried the departments you have selected.  Quantities will be updated ONLY for 
the departments which you have inventoried during this session.  It is recommended that you view the 
discrepancy report one last time before updating quantities to verify that you are ready to perform the 
update.  When the update is performed, it CANNOT be undone.  If you find you need to adjust the 
quantities after you have already performed the update, you will need to do this at the inventory 
maintenance screen.  
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The program will automatically perform a full back up your database before it updates quantities.  If for 
any reason you need to return to your previous quantities, you actually can restore from this backup 
file.  If you run into a situation where you feel you need to revert to the backup, we recommend you 
contact customer support for assistance.  

 
Note:  If for any reason you need to return to your previous quantities, you actually can revert to this 
backup file.  If you run into a situation where you feel you need to revert to the backup, we recommend 
you contact customer support for assistance.  
 
If you wish for any reason to discard the inventory taken thus far, select “Clear Physical Inventory 
Database”. This will delete the quantities and allow you to restart inventory from scratch.  This is 
primarily helpful if you are experimenting with the software rather than actually taking inventory.  Be 
aware that once you select “Clear Physical Inventory Database”, it CANNOT be undone. 
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ESC Mobile Inventory 
 
You will need to have created and uploaded a Palm inventory database using eXtremePOS, Musicware 
or Praiz before launching Mobile Inventory.  For more information on generating the Palm inventory 
database, see your POS software manual. 
 
 

1. Main Screen – This is the startup screen for Mobile Inventory.   
 

 
 

Start – Go to scan screen and begin/continue taking inventory 
 
Options – Go to the options screen to change setup parameters, clear database quantities or view 
database information. 
 
Exit  – Quit the application 

 
 

2. Options screen  
 

 
 

Clear Quantities - allows you to reset the count on all items in your Palm database to zero.  If you 
collect quantities on a dept(s), hot sync those quantities back to your POS software, and wish to 
continue collecting quantities in the same dept(s), you should Clear Quantities before continuing.  
Clearing your quantities will keep you from re-syncing the previous count to your POS software (which 
would result in an inaccurate count).  ESC Mobile Inventory will detect that your data has been Hot 
Synced and will prompt you to Clear Quantities when you restart the software. 
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Check Digit – This button selects whether or not Mobile Inventory should include the check digit 
when looking up an item in your database.  If you include the barcode check digit in your POS software 
inventory database, make sure “Check Digit On” is shown.  If you exclude the barcode check digit in 
your inventory database, make sure “Check digit Off” is shown. 
 
Done – Exit the options screen and return to the main screen 
 

 

3. Scan screen  
 

 
 
Scan Button – Starts the CSM 150 scanner module when in scanner mode.  This button is not available 
in manual mode.  Mobile Inventory will perform a database lookup and show  you the Item number and 
description of item scanned on the screen.   
NOTE: The item is not added to your quantities until you either: 

1. Hit the “Add” button 
2. Scan another item.  This will hit the “Add” button behind the scenes and then display the 

newly scanned item.  If you don’t wish to add the item to your quantities, you should hit 
“Cancel” prior to scanning another item. 

 
Item Number box – In manual mode, this box is used to enter the item number.  In scanner mode, this 
box displays the item number scanned. 
 
Quantity box – Use this box to indicate the quantity of the scanned item to add to inventory.  Quantity 
can only be modified after an item is scanned (or manually entered), but before hitting the “Add” 
button (or scanning another item).  Default quantity is always “1”. 
 
New/Used Select Button – Determines whether to increment new quantity or used quantity for the item 
scanned (or manually entered).  When inventorying a new item, ensure the New/Used Select Button 
shows “New Item”.  When inventorying a used item, ensure the Button shows “Used Item”.  The 
New/Used Button should be toggled only after an item is scanned but before hitting the “Add” button 
(or scanning another item). 
 
Add Button – Adds the quantity in the Quantity Box of the item shown in the Item Number Box to 
either the New or Used Quantities (based on the state of the New/Used Select Button).  The Item 
Number Box and Quantity Box is then cleared and is ready for the next item.   
NOTE: If you have an item in the Item Number box, then scan another item, the program will 
automatically hit the “Add” button and add the item to your quantities before displaying the new item.  
 
Cancel Button – Clears the item number box and quantity box without adding the item to your 
inventory quantities. 
 
Details Button –  Shows the Details screen for the Item in the Item Number box. 
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Mode Select Button – Toggles between Scanner or Manual mode.  As you will most likely be using a 
CSM 150 Scanner Module, you should ensure the Button reads “Scanner”.  To manually enter items, 
ensure the button shows “Manual”.  The application defaults to Scanner mode on startup. 
 

 

4. Details screen  
 

       
 
Tabs - Details screen allows you to quickly view reference data on a scanned item.  Select the 
appropriate tab to view Quantities, General or Price information. 
 
Back – Return to the Scan Screen 
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Physical Inventory from within ExtremePOS  
 
 
 
 

The Physical Inventory Process 
This section will cover the steps involved in taking physical inventory from within ExtremePOS. 
 
 
Step 1: Select the Department to inventory. 
 
Start eXtremePOS and select Tools -> Physical Inventory -> Desktop from the login screen to enter the 
Physical Inventory screen.   
 

 
 
You will be presented with the Department Select screen, depicted below.  Select the department(s) you 
want to inventory.  To inventory your entire store, select “All” from the Department list box.  To select 
multiple departments, hold down the “Control” key and click each department you want to select. 

Note: While taking Physical Inventory, ExtremePOS will only recognize and count items in the 
selected departments. 

 
 

 
 

 
Click the OK button.  This will create a Physical Inventory database in your “Shared Files” directory 
called PI_Sum.mdb.  This Access database file will hold your inventory quantities for the specified 
departments until you are ready to update quantities in your store database. 
 
IMPORTANT : You will need to COMPLETE inventory in the selected departments before you 
update quantities to your store database.  At that point, you will be able to go back and select other 
department(s) to inventory. 
 
 
 
You will now be presented with the main Physical Inventory screen, shown below. 
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You should select “Continue Counting” to bring up the Count screen and begin taking inventory.  
Select “View Depts” if you want to see a list of departments currently being inventoried. 
 

 
Step 2: Collect inventory from the Count Screen 
 
The Count Screen is depicted below.  In order to count an item: 
 
1. Enter the quantity in the Quantity box 
2. Indicate whether this is a new or used item by selecting the appropriate option button. 
3. Scan the item OR type in the item number and hit OK 
 
Information about the item including expected and actual quantities for new and used will be shown in 
the “Last Item Scanned” box. When you have completed taking inventory, exit the Count screen by 
selecting “Done”.  This will return you to the main Physical Inventory screen. 
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Note: ExtremePOS will only recognize and count items in the departments you selected when 
generating the database, so you should only inventory these departments.  You will be able to repeat 
this process as many times as needed in order to inventory all desired departments. 
 
Note:  You can exit physical inventory at any time during the process and resume at a later time by 
again selecting Tools -> Physical Inventory -> Desktop from the login screen.  ExtremePOS will 
indicate that you have a session in progress and allow you to continue counting where you left off. 

 
 
Step 3: View Discrepancy Report 
 
Select View or Print inventory discrepancy report to see all differences between expected and actual 
quantities, and value of any lost inventory.  Discrepancy report addresses both new and used items.  If 
you select to view the report, it will be sent to a text file in your store data directory named 
“DiscRpt.txt”.  You can select to save this to a unique file name if you wish to retain the report.  
Otherwise the report will be overwritten the next time “View Report” is selected. 
 
Note:  When quantities are updated, the final discrepancy report will be automatically saved to your 
store data directory under Backup\Reports.  The filename will be based on the date and time the report 
was created.  The program will inform you of the location and filename that the final report is saved to. 
 
 
Step 4: Update Quantities 
 
Selecting “Update Inventory” will overwrite the quantities in your store database with the counted 
quantities in your physical inventory database.  Update should not be performed until you have 
COMPLETELY inventoried the departments you have selected.  Quantities will be updated ONLY for 
the departments which you have inventoried during this session.  It is recommended that you view the 
discrepancy report one last time before updating quantities to verify that you are ready to perform the 
update.  When the update is performed, it CANNOT be undone.  If you find you need to adjust the 
quantities after you have already performed the update, you will need to do this at the inventory 
maintenance screen.  

 
The program will automatically perform a full back up your database before it updates quantities.  If for 
any reason you need to return to your previous quantities, you actually can restore from this backup 
file.  If you run into a situation where you feel you need to revert to the backup, we recommend you 
contact customer support for assistance.  
 
If you wish for any reason to discard the inventory taken thus far, select “Clear Physical Inventory 
Count”. This will delete the quantities and allow you to restart inventory from scratch.  This is 
primarily helpful if you are experimenting with the software rather than actually taking inventory.  Be 
aware that once you select “Clear Physical Inventory Count”, it CANNOT be undone. 
 
Selecting “Exit” will return you to the Login screen.
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A Quick Tutorial of ExtremePOS 
 

This quick tutorial is designed to familiarize you with ExtremePOS.  For this tutorial, we will be adding 
inventory, departments, and customers for a fictitious company.  We will also process some transactons to 
get a feel for the invoicing process. 
 
 

Log-in Screen 
 
Note:  Musicware and ExtremePOS users will see slightly different screens. 
 

 
 

The first screen that appears when you run PRAIZ® is the Log-in Screen.  To log in, type in the password 
for the shown cashier ID, then press <ENTER> or click on Login.  To log in as the administrator, type in 
the administrator password under any Cashier ID.  To log in as a cashier under a different cashier ID, type 
in the desired ID in the Cashier ID field, then enter that cashier’s password.  You may only change Cashier 
IDs if you have manually added in the ID through the Tools menu.  This option is enabled in both the single 
and multi-user versions.  
 

The default Administrator Password is: admin 
 

The default Cashier Password is: cashier 
 

 



Appendix 
 

ExtremePOS 186 

Add a Department 
 

1. To add a department, click on the View menu, and then click on Departments.   
 
2. A window entitled Department Maintenance will appear on your screen, as shown below: 
 
 

 
 
3. Click on Add. 
 
4. For Department ID, enter 7. 
 
5. Use <TAB> to move from Department ID to Department Description. 
 
6. For Department Description, enter DVD/Audio DVD . 
 
7. Choose the Department Type as Regular. 
 
8. Click on Save.  You have just entered a department. 
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Add a Category 
 
 

1. To add a category, click on the View menu, and then click on Departments. 
 
2. A window entitled Category Maintenance will appear on your screen, as shown below: 

 

 
 

3. Click on Add. 
 

4. For Category ID, enter 100. 
 

5. Use <TAB> to move from Category ID to Category Description. 
 

6. For Category Description, enter ROCK/POP. 
 

7. Click Save.  You have just entered a category. 
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Add a Vendor 
 

1. To add a vendor, click on the View menu, and then click on Vendors.  Select Vendor Maintenance. 
 
2. A window entitled Vendor Maintenance will appear on your screen, as shown below: 
 

 
 

3. Click on Add. 
 
4. For Vendor Number, enter 1000. 
 
5. Press <TAB> to move the cursor to the Company Name field.  Type ExtremePOS. 
 
6. Press <TAB> to move the cursor to the Contact First Name field, and type John.  Press <TAB> to 

move the cursor to the Contact Last Name field, and then type Smith. 
 
7. Press <TAB> to move the cursor to the Address fields.  Type 1234 Any Street.  Move the cursor to 

the City  field, and then type Anytown.  Move the cursor to the State and Zip Code fields, and then 
type NC and 27502. 

 
8. Move the cursor to the Telephone Number field, and then type 555-555-5555.  Press <TAB> to move 

the cursor to the Fax Telephone Number field, and then type 555-555-6666. 
 
9. Click on Save.  You have just added a vendor. 
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Add an Inventory Item 
 

1. To add inventory, click on the View menu, then select Inventory .  The screen below should appear: 
 

 
 

2. Click on Add. 
 
3. Click on the Item Number field and type or scan 07777461012, or the item number you are adding. 
 
4. Click on Item Number Type and select the appropriate type for the number you are adding. 
 
5. Click in the Item Name field and type the “title” of the item you are adding. 
 
6. Click in the Item Description or press <TAB> and enter MILLER, STEVE BAND .   
 
7. Press <TAB> and move to the Manufacturer field and enter CAP. 
 
8. Click on the department list box and select a Department. 
 
9. Click on category field and select a Category. 
 
10. Press <TAB> to move the cursor to the In Stock field.  This field specifies how much of the item you 

have in stock.  Type 10. 
 
11. Click on the Cost field.  The Cost is how much the item cost to purchase from the vendor.  Type 7.67. 
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12. Press <TAB> to move the cursor to the Price field.  The Price is for how much the item is being sold.  
Type 10.39. 

 
13. Press <TAB> to move the cursor to the Retail Price field.  The Retail Price is a reference field.  It can 

be used to record how much the item in question is going for in the market.  Type 11.97. 
 
14. Click on Tax 1. 
 
15. Click on the Reorder Level field.  This field specifies the level the In Stock amount should drop below 

before needing to reorder this item, for example type 1.  When the In Stock quantity drops to 0, this 
will trigger a reorder of the quantity specified in the Reorder Quantity field. 

 
16. Press <TAB> to move the cursor to the Reorder Quantity field.  This field specifies how much of the 

item should be reordered at a time.  Type 1. 
 
17. Click on the other tabs to display more options for an inventory item.  Enter information as needed.  

Once you have finished entering all the information for an item, click on Save.  You have just added an 
item to your inventory. 
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Add an Employee 
 

1.  At the primary login screen, select Tools and then Employee Maintenance.  The following 
screen should appear: 

 
 

 

 
 

2. Hit the Add button or <Alt+I> . 

 
3. Enter a two-digit unique cashier id in the cashier id field. 

 
4. Enter a password for the cashier. 

 
5. You may, if you choose, associate a customer number with this employee for the purposes of 

tracking contact information.  If so, hit the associated customer number button to select one. 
 

6. You may also enter a card swipe ID, an hourly wage, and a employee department with this 
employee.  These are all optional. 
 

7. Click the Permissions tab.  You should now see the following screen: 
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8. Set the new employee’s permissions by clicking the drop-down menu next to each item.   No 
means the system will not allow that employee to perform the action, Yes allows them to, Prompt 
will ask for the admin or an override user’s login to access the action, and Override gives the user 
both the ability to perform the action themselves and to allow prompted users to do so. 

 
9. Hit the Update button. 
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Add a Customer 
 
 

1. To add a customer, click on the View menu, and then select Customers.  The Customer Maintenance 
screen, shown below, should appear: 

 

 
 

2. Click on Add. 
 
3. Assign a Customer Number in the Customer Number field.  It is recommended that you use the 

customer’s telephone number or driver’s license number.  For this customer, type 8006479711. 
 
4. Press <TAB> to move the cursor to the First Name field.  Type Joe. 
 
5. Press <TAB> to move the cursor to the Last Name field.  Type Miller . 
 
6. Press <TAB> to move the cursor to the Company Name field.  Type ExtremePOS. 
 
7. Press <TAB> to move the cursor to the Street Address field.  Type 5540 Centerview Drive, Ste 200. 
 
8. Press <TAB> to move the cursor to the City  field.  Type Raleigh. 
 
9. Press <TAB> to move the cursor to the State field.  Type NC. 
 
10. Press <TAB> to move the cursor to the Zip Code field.  Type 27606. 
 
11. Press <TAB> to move the cursor to the Primary Phone Number field.  Type 800-647-9711. 
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12. Press <TAB> to move the cursor to the Email field and type sales@extremepointofsale.com. 
 
13. Click on the arrow next to the Discount Level field and choose A. 
 
14. Click on Save.  You have just added a customer with only the basic customer information.  You may 

need to enter the information in other fields later on down the road.  NOTE:   EXTREMEPOS does not 
require you to enter customers.  The default will always be Cash Customer. 
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Make a Purchase Order 
 

1. Before making a purchase order, you must have at least one vendor set up.  See the relevant 
tutorial above. 
 

2. From the main invoice screen, either hit <Ctrl + P> or go to the Actions menu and then Purchase 
orders.  You will see the following screen: 
 

 
 

3. Hit the add button.  The following screen will appear: 
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4. Select a vendor from the list.  Enter a due date in MM/DD/YYYY format.  The other fields are for 
your reference, but the first two are required by the software. 
 

5. Hit the View/Add Items tab to bring up a blank list of items to receive.  You may add items by 
doing a search for them or by entering or scanning the bar code associated with them.  Hit Save to 
save the purchase order. 
 

6. You may add to the order by selecting it from the main purchase order screen and hitting edit.  
This will allow you to change the order as you like.  When finished, hit Update to save the 
changes. 
 

7. When ready to receive the order, go into it as listed in step 6 above.  You may either receive all 
items at once or receive line by line.  Hitting update will update your inventory to reflect received 
items.   Hitting close will permanently close the purchase order, and should be done once the order 
is fully finished and received.  However, it is irreversible, and so should only be done after 
checking for errors. 
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Install the BRE database 
 

1. The BRE database is a subscription service, and you must have a current subscription before using 
it. 

 
2.  In the main invoice screen, go to Tools and then Options.  On the left hand side, go to the 

Vendor Databases option on the left.  Check Quick Import  and Save Check Digits on Imported 
UPCs, and then set the BRE database in one of the dropdown menus below that. 
 

3. Exit ExtremePOS and run the BRE manager software from the launchpad.  Hit the check for 
database update button. 
 

4. If you would like to update your in-inventory pricing, check the relevant boxes and hit perform 
update. 
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Install the VPD database 
 

1. The VPD database is available to registered users of ExtremePOS. 
 
2.  In the main invoice screen, go to Tools and then Options.  On the left hand side, go to Internet 

Options.  Enter your VPD username and password in the spaces under the VPD Database header. 
 

3. Still in options, go to the Vendor Databases option on the left.  Check Quick Import  and Save 
Check Digits on Imported UPCs, and then set the VPD database in one of the dropdown menus 
below that. 
 

4. Exit ExtremePOS and run the VPD manager software from the launchpad.  Hit the check for 
database update button. 
 

5. If you would like to update your in-inventory pricing, check the relevant boxes and hit perform 
update. 



 

ExtremePOS 199

 

 
Install the Superfile database 

 
1.  You must have the Superfile database downloaded in the form of a zip file prior to following these 

instructions.  The Superfile database is a subscription service; you will need to purchase updates  
from SuperD if you wish to keep it up-to-date. 
 

2. Extract the zip file on the server station to the vendors directory within your shared files.  For 
MOST users, this will be C:\program files\extremeposmaint\shared_files\vendors\  
 

3. From the login screen, go to Tools, Vendor Databases, Superfile, and then to Create Database. 
 

4. At the bottom of the screen, change the files of type dropdown menu to All Files.  Open the file 
named SFA8. 
 

NOTE THAT THIS PROCESS TAKES SEVERAL HOURS AND SHOULD NOT BE DONE WHEN 
THE SYSTEM WILL BE NEEDED. 
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Set Up a Discount Card 
 
 

1. Go into view -> promotions and create a promotion (or more than one if desired).  
Designate the promotion as “Discount card only” when you create it. 

2. Go into Inventory Maintenance and create a discount card item.  Create a new item, 
assign it an item number and name as desired.  Check off “This item is a discount card”, 
then click on “Select promotions” button which will become enabled.  This brings you to a 
screen where you can select promotions to associate with the discount card.  When 
you’re done, exit back into inventory maintenance and save your item. 

3. Select a customer for an invoice and scan or enter the item number for the discount card.  
You will need to assign a unique number to the discount card, which should be preprinted 
or written onto the card.  This will be used to identify the card when it’s used in the future.  
Complete the sale.  The expiration date on the card  is currently fixed at 1 year from date 
of purchase. 

4. Start another invoice.  On the invoice screen, select “Scan discount card” and scan or 
enter the card number (this is the unique card number printed or written on the card, NOT 
the item id you gave it for sale purposes).  This should automatically bring up the 
customer who purchased the card.  Scan in some items that should trigger a promotion 
which you associated with that card.  The software will automatically apply the promotion 
pricing to items on that invoice. 



 

ExtremePOS 201

 
 

 

Use Preoders and Special Orders 

Setting an item up for preordering: 

 

1. Under inventory maintenance, add the item or select the item you wish to take preorders on. 

2. Under the optional tab for that item, check the Pre-Order Item box.  Put the minimum deposit you will 

take in the Minimum Payment box. 

3.  If the item must not be sold before a certain date, put that date in mm/dd/yyyy format (I.E. 11/31/2008) 

in the street date box.  If you do not want to take preorders on a item before a certain date, put that date in 

the Preorder date box. 

4.  Update the item.  It is now set up for preordering! 
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Setting items up for special ordering: 

 

1.  Under tools and options, go to the invoice tab. 

2.  Under the Stock Prompt option, check enable. 

3.  Hit the update button.  The POS system will now prompt you asking if you would like to place a special 

order when you attempt to scan something that is out of stock. 

Placing a preorder: 

1.  Select a customer.  There must be a specific customer (NOT the cash customer) associated with all 

preorders and special orders. 

2.  Scan or type in the item number associated with an item set up for preordering.  The system will prompt 

you asking if you want to sell a preorder.  Say yes. 
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3.  Enter the customer's deposit and the expected pickup date.  The preorder will be placed on the invoice. 

 

4.  Ring the item out as normal. 
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Picking up a preorder/special order: 

 

1.  Access the special orders screen, either through View to Special Order/Preorders or by selecting the 

customer and hitting the Special Orders button on the invoice screen. 

2.  Click the preorder to be picked up, then click the add to invoice button.  Do this for all items being 

picked up by this customer. 

3.  Click exit and ring the transaction out as normal.  The amount deposited by the customer will 

automatically be included at the tender screen. 
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Refunding a preorder/special order: 

1.  Access the special orders screen, either through View to Special Order/Preorders or by selecting the 

customer and hitting the Special Orders button on the invoice screen. 

2.  Click the preorder to be refunded, then click the cancel button.  Do this for all items being canceled by 

this customer. 

3.  Ring the transaction out as normal for a refund transaction. 
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Process a Cash Transaction 
 

Processing a cash transaction involves selecting the customer who wishes to make a purchase and finding 
the item that the customer wants to purchase. 
 

 
 
To select a customer: 
 
1. In the center of the main invoice screen, there is a group of buttons showing the current customer.  

These buttons are Details, Lookup and Quick Search.  The buttons are shown below: 
 

 
 

2. Clicking on Lookup will take you to the Customer Maintenance screen and allowing you to find the 
customer by name or number.  Clicking on Quick Search will allow you to “type” or “scan” the 
customer’s number and thereby quickly selecting the customer for the current invoice. 

 
3. Let’s select the customer you just created by clicking on Quick Search and typing 8006479711.  The 

customer information will appear in the customer window. 
 
4. Click on Details to display the complete customer information. 
 
5. Next, we need to find the inventory that the customer wishes to purchase.  Above the Current 

Customer area there is another area entitled Search By.  This is where we choose the item and the 
quantity to be purchased. 

 
To choose an inventory item: 
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1. Click in the Item Number field or press <ALT+I>  to give focus to the field.  Now “scan” or “type” 
07777461012 to enter the inventory item we created earlier.  If you type the number, press enter to 
complete the search. 

 

 
 
2. As an alternative, you can click on the Lookup button or use the hotkey <F10> to manually select the 

item from a detailed lookup screen. 
 
3. The item will appear in the invoice grid in the middle half of the invoice screen.  If you need to change 

the quantity, price, etc. just choose the appropriate button at the bottom of the screen: 
 

 
 
4. To finalize this invoice just click on End Transaction at the bottom right corner of the screen.  You 

will be prompted to enter the amount tendered.  Enter the amount tendered if it is different than the 
amount displayed, and then click on OK .   

 

 
 
5. A window will appear displaying the change for the customer.  Click on OK  when you are finished. 

Congratulations, you have just processed a cash invoice. 
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Shortcut Keys 
 

 
Customer Maintenance 
Customer – Look Up Customer 
Daily Gross Profits 
Discount – Invoice Discount 
Discount – Line Discount 
Gift Cards 
Help – Invoice Screen Help 
Inventory Maintenance 
Inventory/Kit Sort Order – Sort by Item Name 
Inventory/Kit Sort Order – Sort by Item Number 
Invoice – Void This Invoice 
Kit Maintenance 
Non-Inventory Item 
Payment – Cash 
Payment – Credit Card 
Payment – Check 
Payment – On Account 
Price Check 
Purchase Orders 
Return Rentals 
Last Invoice Processed 
Print Last Invoice Processed 
Select Invoice Grid 
Tax – No Tax This Order 
Tax – Tax This Order 
Tax – Set Tax Rate 

<F3> 
<ALT+L> 
<SHIFT+F1> 
<CTRL+D> 
<CTRL+L> 
GC in Item Number 
<F1> 
<F2> 
<SHIFT+F7> 
<SHIFT+F8> 
<CTRL+V> 
<SHIFT+F3> 
<CTRL+N> 
<F6> 
<F7> 
<F8> 
<F9> 
<F5> 
<CTRL-P> 
<CTRL+F1> 
<CTRL+F8> 
<SHIFT+CTRL+F8> 
<CTRL+G> 
<CTRL+X> 
<CTRL+O> 
<CTRL+T> 

 
 
NOTE:  These shortcut keys only work from the main ExtremePOS invoice screen.  If any control has an 
underscore (_) under a letter, that option can be activated by pressing <ALT>  + <LETTER WITH 
UNDERSCORE>.  For example, the menu command Exit  can be activated by clicking on Exit  or by 
pressing <ALT+ X> . 



 

 

Common Questions and Answers 
 

 
Q: I often get messages that I should register within the next 200 invoices, but I never got around to 
it.  Now I get a message that says the 200 invoice limit was exceeded and I can no longer get into 
ExtremePOS.  What do I do now? 
 
A: Call your dealer.  They will help you on the proper registration process. 
 
 
Q: I am using a barcode reader or wand.  When I scan the barcode, either no numbers show up or 
not all the numbers show up.  Why is this happening? 
 
A: Your barcode reader or wand is probably not set up correctly.  To test this, try scanning a barcode in 
DOS or in a simple program such as Microsoft Notepad.  If the numbers on your barcode are not showing 
up correctly, your barcode reader or wand is not set up properly.  Check the manual of your input device for 
help with setting up your barcode reader or wand. 
 
Q: I accidentally added the wrong item onto an invoice.  How do I get this item off of the invoice? 
 
A: Press <CTRL+G>  to set the focus to your invoice grid.  Use the arrow keys to move the box onto the 
line of the item you would like to delete from your invoice.  Press <DELETE>  to delete the item from your 
invoice. 
 
Q: My customer bought something and now wants to return his purchase.  How do I do this? 
 
A: To do a return in EXTREMEPOS, all you have to do is create a new invoice in which you add the items 
to the invoice with a negative quantity.  For example, if a customer bought two boxes of diskettes from you, 
you would add –2 boxes of diskettes to the invoice.  EXTREMEPOS will automatically take money out of 
your profits and update the quantity. 
 
Q: Why can’t I enter departments in the Inventory screen? 
 
A: You must enter your departments in the Department Maintenance screen and then they will be made 
available for selection from the Inventory Maintenance screen. 
 
 
Q: What is the ****non-inventory**** item for and c an I delete it? 
 
A: No, you should not delete it or modify it.  You will need this item in your inventory in order to add Non-
Inventory  items to your invoice.  If this item is deleted, the Non-Inventory feature will not work properly. 
 
 
Q: Which printer driver should I use for my receipt printer?  
 
A: Generic/Text Only is the required printer driver and is included with Windows.  It can be set from the 
Set Default Printer option from the Actions menu of the Main Invoice Screen. 
 
Q: Why doesn’t my barcode printer work? 
 
A: You probably have not installed the correct printer driver for your model printer.  Please make sure that 
you install the appropriate driver from the CD-ROM that shipped with your printer.  To can view your 
existing printers within Windows under the Settings> Control Panel>Printers menu. 
 



 
 

 

 
Q: How can I enter additional Cashier IDs? 
 
A: To add a Cashier ID, select Employee Maintenance from the Tools menu in the Log-In Screen.  You 
will be prompted to enter the administrator’s password.  Click on Add or press <ALT+A> . Enter the new 
Cashier ID and the employee’s information.  When you are finished, click on Done or press <ALT+D> .  To 
quit without adding a Cashier ID, click on Cancel or press <ALT+C> .  NOTE: Cashier IDs must be two 
characters long.  The default password for new cashiers is Cashier.  You may change this password in 
Employee Maintenance. 
 
 
Q: Where does ExtremePOS store all of my information? 
 
A: All of your information (invoices, customers, vendors, inventory, etc.) is stored in the ESC_V20 
database.  The Database Management System used by ExtremePOS is Microsoft SQL Server Desktop 
Engine, which is a scaled down version of the full SQL Server product.  The database file is physically 
located in the SQL Server data directory. 
 
 
Q: Why can’t I delete inventory items? 
 
A: If an inventory item has never been used in a past invoice, you are free to delete it.  However, if an item 
has been used in a past invoice, you cannot delete it.  An extra few items will not take up space or slow you 
down in any way.  Also, if you are trying to get a detailed sales history, it is important that all the proper 
information is there to recall when it is needed.  If the item were deleted, you could not get an accurate 
report. 
 
Q: Why does my cash drawer not open? 
 
A:  There is a known issue where the cash drawer will not open on or before the first transaction after 
opening the software.  Try again after ringing someone out.  If the drawer still does not open, first ensure 
that it is enabled in the options menu (Tools then Options from the main invoicing screen) and second 
ensure that the cable is plugged in correctly.  The cable for the cash drawer is one way, and the ends are 
labeled: EPSON or STAR goes to the receipt printer, C/D to the cash drawer. 
 
Q: Why do I get an error when trying to update? 
 
A: There are two main reasons:  either you have a firewall blocking the program from accessing the update 
server, or else you do not have your correct, current username and password entered into the program. 
 
Q: My display pole is showing odd things such as ‘btotal=’ the price and receipts are not printing. 
 
A: This is caused by initializing the display pole improperly.  Turn it off and exit the software, then turn the 
display pole back on.  When you reenter the software, it should work.  If not, make certain that the display 
pole is configured correctly in the options menu.  Additionally, on the bottom of the display next to the 
power switch are a series of small white switches.  Make sure that the sixth is enabled and no others are. 



 

 

Technical Support & Hardware Service Contract 
 

 
Technical support and Extreme Point of Sale, Inc. supplied software updates 
are FREE for 90 days from date of purchase.  The plans below are only valid 
when subscribed to before the “FREE” period expires.  Otherwise, the user 
must first upgrade to the newest version and then purchase a contract. Full 
phone support plans also include a hardware warranty that will replace 
defective Extreme Point of Sale, Inc. supplied hardware with a similar 
working replacement until which time Extreme Point of Sale, Inc repairs the 
user’s original hardware.  Extreme Point of Sale, Inc. reserves the right to 
replace the item instead of repairing the originally purchased unit.  Ground 
shipping of replacement items from Extreme Point of Sale, Inc will be 
covered at no additional charge.  The user is responsible for shipping to 
Extreme Point of Sale, Inc.  Additional charges will apply should the user 
require expedited shipping of the replacement units or parts.  Warranty only 
applies to hardware purchased if support has been continuous since 
purchase date. 
 
The charge for software updates is $100 per quarter per station.  There is an 
additional $100 per quarter per store charge for phone support.  There is a 
$55 per half hour charge for phone calls for users not on a phone support 
contract, with a minimum of half hour charged per call. 

 

  
Technical support hours are from 9 AM – 5 PM EST, Monday – Friday, by calling 
919-387-7597  or emailing support@extremepos.com 
 

����   Decline support and updates 
 
����   Check or Money Order         ����   Visa           ����   MasterCard         ����   AMEX 
 
Name on Credit Card 
______________________________________________ 
 
Company Name 
__________________________________________________ 
 
Street Address 
___________________________________________________ 
 
City, State and Zip Code 
___________________________________________ 
 
Credit Card Number 
_______________________________________________ 
 
Credit Card Exp Date _________________ Today’s Date ____________ 
 
Signature 
_______________________________________________________ 
 
BUYER ACKNOWLEDGES THAT IT HAS READ THIS AGREEMENT, AND UNDERSTANDS AND 
AGREES TO ALL TERMS AND CONDITIONS STATED HEREIN. 



 
 

 

 
 

 Support Frequently Asked Questions 
 
 

 
� Busy Signals when calling for technical support. Our technical support 

lines are free at least 40% of the day between 9 AM and 5 PM, EST, M-
F. We do not place callers in a queue to wait for the next available 
support person. If you get our voice mail, please leave a message 
under the support option so we can return your call in a timely 
fashion.  You may also try one of the below options for additional or 
alternative support methods. 

 
� Support Via Email. You can get support by writing to 

support@extremepos.com. This email address is monitored daily.  You 
will normally receive a reply the same day if submitted by 3 pm EST. 

 
� Network Problems. If you have two or more computers connected via 

a network and you did not purchase your network from ExtremePOS, 
we cannot support your network at no charge. Our technician will ask 
you questions to confirm that your network is operational.  If your 
network is not functioning, you must seek help from the person who 
installed your network, or ExtremePOS can help you get your network 
working via a $99 tech support fee. 

 
� Other Hardware Problems. If you purchased your hardware from a 

company other than Extreme Point of Sale, Inc., or its dealers, we 
cannot give you hardware support at no charge. We have methods of 
testing most of your hardware. If your hardware is not working 
properly, you must go back to your original hardware supplier for 
support. The most frequent problems we find with hardware are serial 
port conflicts with modems and modem software and printer conflicts 
with certain printers which have software that takes over the parallel 
port. 

 

 
 
 
 
 
 
 
 
 
 
 


